Contents

Using This Book ................................................................................................................................. ix
Acknowledgments ................................................................................................................................. xvii

1 Basic Concepts in Research and Data Analysis ................................................................. 1
   Overview ........................................................................................................................................... 1
   Introduction: A Common Language for Researchers................................................................. 2
   Steps to Follow When Conducting Research ........................................................................... 3
   Variables, Values, and Observations ......................................................................................... 8
   Scales of Measurement and JMP Modeling Types ............................................................... 10
   Basic Approaches to Research .................................................................................................. 14
   Descriptive versus Inferential Statistical Analysis ............................................................... 18
   Hypothesis Testing ..................................................................................................................... 20
   Summary ....................................................................................................................................... 29
   References .................................................................................................................................... 29

2 Getting Started with JMP ........................................................................................................... 31
   Overview ........................................................................................................................................ 31
   Start the JMP Application .......................................................................................................... 32
   The JMP Approach to Statistics ............................................................................................... 35
   A Step-by-Step JMP Example ................................................................................................... 36
   Summary ....................................................................................................................................... 45
   References .................................................................................................................................... 45

3 Working with JMP Data ............................................................................................................. 47
   Overview ........................................................................................................................................ 47
   Structure of a JMP Table .............................................................................................................. 48
   JMP Tables, Rows, and Columns ............................................................................................. 52
   Getting Data into JMP ................................................................................................................. 61
   Data Table Management .......................................................................................................... 70
### Contents

*Summary*: ................................................................................................................................. 83  
*References*: ............................................................................................................................. 84

#### 4 Exploring Data with the Distribution Platform ................. 85
Overview ....................................................................................................................................... 85  
Why Perform Simple Descriptive Analyses? ................................................................. 86  
Example: The Helpfulness Social Survey .............................................................................. 87  
Computing Summary Statistics .............................................................................................. 90  
A Step-by-Step Distribution Analysis Example .................................................................. 118  
*Summary*: ................................................................................................................................. 118  
*References*: ............................................................................................................................. 119

#### 5 Measures of Bivariate Association ........................................ 121
Overview ..................................................................................................................................... 121  
Significance Tests versus Measures of Association ........................................................... 123  
Choosing the Correct Statistic ............................................................................................... 124  
Section Summary .................................................................................................................... 129  
Pearson Correlations .............................................................................................................. 130  
Spearman Correlations .......................................................................................................... 146  
The Chi-Square Test of Independence ................................................................................. 148  
Fisher’s Exact Test for 2 X 2 Tables ...................................................................................... 159  
*Summary*: ................................................................................................................................. 160  
Appendix: Assumptions Underlying the Tests .................................................................. 161  
*References*: ............................................................................................................................. 162

#### 6 Assessing Scale Reliability with Coefficient Alpha .......... 163
Overview ..................................................................................................................................... 163  
Introduction: The Basics of Scale Reliability ....................................................................... 164  
Cronbach’s Alpha ................................................................................................................... 168  
Computing Cronbach’s Alpha .............................................................................................. 169  
Summarizing the Results ........................................................................................................ 178  
*Summary*: ................................................................................................................................ 179  
*References*: ............................................................................................................................. 180
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>t-Tests: Independent Samples and Paired Samples</td>
<td>181</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>181</td>
</tr>
<tr>
<td></td>
<td>Introduction: Two Types of t-Tests</td>
<td>182</td>
</tr>
<tr>
<td></td>
<td>The Independent-Samples t-Test</td>
<td>184</td>
</tr>
<tr>
<td></td>
<td>The Paired-Samples t-Test</td>
<td>205</td>
</tr>
<tr>
<td></td>
<td>Summary</td>
<td>221</td>
</tr>
<tr>
<td></td>
<td>Appendix: Assumptions Underlying the t-Test</td>
<td>221</td>
</tr>
<tr>
<td></td>
<td>References</td>
<td>223</td>
</tr>
<tr>
<td>8</td>
<td>One-Way ANOVA with One Between-Subjects Factor</td>
<td>225</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>225</td>
</tr>
<tr>
<td></td>
<td>Introduction: Basics of One-Way ANOVA Between-Subjects Design</td>
<td>226</td>
</tr>
<tr>
<td></td>
<td>Example with Significant Differences between Experimental Conditions</td>
<td>231</td>
</tr>
<tr>
<td></td>
<td>Example with Nonsignificant Differences between Experimental Conditions</td>
<td>248</td>
</tr>
<tr>
<td></td>
<td>Understanding the Meaning of the F Statistic</td>
<td>251</td>
</tr>
<tr>
<td></td>
<td>Summary</td>
<td>253</td>
</tr>
<tr>
<td></td>
<td>Appendix: Assumptions Underlying One-Way ANOVA with One Between-Subjects Factor</td>
<td>253</td>
</tr>
<tr>
<td></td>
<td>References</td>
<td>254</td>
</tr>
<tr>
<td>9</td>
<td>Factorial ANOVA with Two Between-Subjects Factors</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Introduction to Factorial Designs</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Some Possible Results from a Factorial ANOVA</td>
<td>260</td>
</tr>
<tr>
<td></td>
<td>Example with Nonsignificant Interaction</td>
<td>268</td>
</tr>
<tr>
<td></td>
<td>Example with a Significant Interaction</td>
<td>287</td>
</tr>
<tr>
<td></td>
<td>Summary</td>
<td>295</td>
</tr>
<tr>
<td></td>
<td>Appendix: Assumptions for Factorial ANOVA with Two Between-Subjects Factors</td>
<td>295</td>
</tr>
<tr>
<td></td>
<td>References</td>
<td>296</td>
</tr>
<tr>
<td>10</td>
<td>Multivariate Analysis of Variance (MANOVA) with One Between-Subjects Factor</td>
<td>297</td>
</tr>
<tr>
<td></td>
<td>Overview</td>
<td>297</td>
</tr>
<tr>
<td></td>
<td>Introduction: The Basics of Multivariate Analysis of Variance (MANOVA)</td>
<td>298</td>
</tr>
</tbody>
</table>
Contents

A Multivariate Measure of Association ................................................................. 300
The Commitment Study ....................................................................................... 301
Overview: Performing a MANOVA with the Fit Model Platform ...................... 303
Example with Significant Differences between Experimental Conditions .......... 305
Example with Nonsignificant Differences between Experimental Conditions .... 316
Summary .............................................................................................................. 318
Appendix: Assumptions Underlying MANOVA with One Between-Subjects Factor ................................................................. 318
References ............................................................................................................ 320

11 One-Way ANOVA with One Repeated-Measures Factor ...... 321
Overview .............................................................................................................. 321
Example with Significant Differences in Investment Size across Time ............... 325
Repeated-Measures Design versus the Between-Subjects Design ..................... 338
Univariate or Multivariate ANOVA for Repeated-Measures Analysis? ............... 342
Summary .............................................................................................................. 354
Appendix: Assumptions of the Multivariate Analysis of Design with One
Repeated-Measures Factor ............................................................................. 354
References ............................................................................................................ 355

12 Factorial ANOVA with Repeated-Measures Factors and Between-Subjects Factors ................................................................................................. 357
Overview .............................................................................................................. 357
Introduction: The Basics of Mixed-Design ANOVA ........................................... 359
Possible Results from a Two-Way Mixed-Design ANOVA ................................ 365
Problems with the Mixed-Design ANOVA ........................................................ 371
Example with a Nonsignificant Interaction ......................................................... 372
Example with a Significant Interaction .............................................................. 393
Summary .............................................................................................................. 401
Appendix A: An Alternative Approach to a Univariate Repeated-Measures Analysis ................................................................. 402
Appendix B: Assumptions for Factorial ANOVA with Repeated-Measures and Between-Subjects Factors ................................................................. 406
References ............................................................................................................ 408
Overview

This chapter describes the differences between the independent-samples $t$-test and the paired-samples $t$-test, and shows how to perform both types of analyses. An example of a research design is developed that provides data appropriate for each type of $t$-test. With respect to the independent-samples test, this chapter shows how to use JMP to determine whether the equal-variances or unequal-variances $t$-test is appropriate, and how to interpret the results. There are analyses of data for paired-samples research designs, with discussion of problems that can occur with paired data.
Introduction: Two Types of \( t \)-Tests

A \( t \)-test is appropriate when an analysis involves a single nominal or ordinal predictor that assumes only two values (often called treatment conditions), and a single continuous response variable. A \( t \)-test helps you determine if there is a significant difference in mean response between the two conditions. There are two types of \( t \)-tests that are appropriate for different experimental designs.

First, the independent-samples \( t \)-test is appropriate if the observations obtained under one treatment condition are independent of (unrelated to) the observations obtained under the other treatment condition. For example, imagine you draw a random sample of subjects, and randomly assign each subject to either Condition 1 or Condition 2 in your experiment. You then determine scores on an attitude
scale for subjects in both conditions, and use an independent-samples *t*-test to
determine whether the mean attitude score is significantly higher for the subjects
in Condition 1 than for the subjects in Condition 2. The independent-samples
*t*-test is appropriate because the observations (attitude scores) in Condition 1 are
unrelated to the observations in Condition 2. Condition 1 consists of one group
of people, and Condition 2 consists of a different group of people who were not
related to, or affected by, the people in Condition 1.

The second type of test is the *paired-samples* *t*-test. This statistic is appropriate if
each observation in Condition 1 is paired in some meaningful way with a
Corresponding observation in Condition 2. There are a number of ways that this
pairing happens. For example, imagine you draw a random sample of subjects
and decide that each subject is to provide two attitude scores—one score after
being exposed to Condition 1 and a second score after being exposed to
Condition 2. You still have two samples of observations (the sample from
Condition 1 and the sample from Condition 2), but the observations from the two
samples are now related. If a given subject has a relatively high score on the
attitude scale under Condition 1, that subject might also score relatively high
under Condition 2. In analyzing the data, it makes sense to pair each subject’s
scores from Condition 1 and Condition 2. Because of this pairing, a paired-
samples *t* statistic is calculated differently than an independent-samples *t*
statistic.

This chapter is divided into two major sections. The first deals with the
independent-samples *t*-test, and the second deals with the paired-samples test.
These sections describe additional examples of situations in which the two
procedures might be appropriate.

Earlier, you read that a *t*-test is appropriate when the analysis involves a nominal
or ordinal predictor variable and a continuous response. A number of additional
assumptions should also be met for the test to be valid and these assumptions are
summarized in an appendix at the end of this chapter. When these assumptions
are violated, consider using a nonparametric statistic instead. See *Basic Analysis
and Graphing* (2012), which is found on the *Help* menu, for examples of
nonparametric statistics.
The Independent-Samples $t$-Test

Example: A Test of the Investment Model

The investment model of emotional commitment (Rusbult, 1980) illustrates the hypothesis tested by the independent-samples $t$-test. As discussed in earlier chapters, the investment model identifies a number of variables expected to affect a subject’s commitment to romantic relationships (as well as to some other types of relationships). Commitment can be defined as the subject’s intention to remain in the relationship and to maintain the relationship. One version of the investment model predicts that commitment will be affected by four variables—rewards, costs, investment size, and alternative value. These variables are defined as follows.

*Rewards* are the number of “good things” that the subject associates with the relationship (the positive aspects of the relationship).

*Costs* are the number of “bad things” or hardships associated with the relationship.

*Investment Size* is the amount of time and personal resources that the subject has “put into” the relationship.

*Alternative Value* is the attractiveness of the subject’s alternatives to the relationship (the attractiveness of alternative romantic partners).

At least four testable hypotheses can be derived from the investment model as it is described here.

- Rewards have a causal effect on commitment.
- Costs have a causal effect on commitment.
- Investment size has a causal effect on commitment.
- Alternative value has a causal effect on commitment.

This chapter focuses on testing only the first hypothesis: the prediction that the level of rewards affects commitment.

Rewards refer to the positive aspects of the relationship. Your relationship would score high on rewards if your partner were physically attractive, intelligent, kind,
fun, rich, and so forth. Your relationship would score low on rewards if your partner were unattractive, unintelligent, unfeeling, dull, and so forth. It can be seen that the hypothesized relationship between rewards and commitment makes good intuitive sense: an increase in rewards should result in an increase in commitment. The predicted relationship between these variables is illustrated in Figure 7.1.

**Figure 7.1: Hypothesized Causal Relationship between Rewards and Commitment**

There are a number of ways that you could test the hypothesis that rewards have a causal effect on commitment. One approach involves an experimental procedure in which subjects are given a written description of different fictitious romantic partners and asked to rate their likely commitment to these partners. The descriptions are written so that a given fictitious partner can be described as a “high-reward” partner to one group of subjects, and as a “low-reward” partner to a second group of subjects. If the hypothesis about the relationship between rewards and commitment is correct, you expect to see higher commitment scores for the high-reward partner. This part of the chapter describes a fictitious study that utilizes just such a procedure, and tests the relevant null hypothesis using an independent-samples *t*-test.

**The Commitment Study**

Assume that you have drawn a sample of 20 subjects, and have randomly assigned 10 subjects to a high-reward condition and 10 to a low-reward condition. All subjects are given a packet of materials, and the following instructions appear on the first page:
In this study, you are asked to imagine that you are single and not involved in any romantic relationship. You will read descriptions of 10 different “partners” with whom you might be involved in a romantic relationship. For each description, imagine that you are involved in a romantic relationship with that person. Think about what it would be like to date that person, given his/her positive features, negative features, and other considerations. After you have thought about it, rate how committed you would be to maintaining your romantic relationship with that person. Each “partner” is described on a separate sheet of paper, and at the bottom of each sheet there are four items with which you can rate your commitment to that particular relationship.

The paragraph that described a given partner provides information about the extent to which the relationship with that person was rewarding and costly. It also provided information relevant to the investment size and alternative value associated with the relationship.

**The Dependent Variable**

The dependent variable in this study is the subject’s commitment to a specific romantic partner. It would be ideal if you could arrive at a single score that indicates how committed a given subject is to a given partner. High scores would reveal that the subject is highly committed to the partner, and low scores would indicate the opposite. This section describes one way that you could use rating scales to arrive at such a score.

At the bottom of the sheet that describes a given partner, the subject is provided with four items that use a 9-point Likert-type rating format. Participants are asked to respond to these items to indicate the strength of their commitment to the partner described on that page. The following items are used in making these ratings.
Notice that, with each of the preceding items, circling a higher response number (closer to “9”) reveals a higher level of commitment to the relationship. For a given partner, the subject’s responses to these four items were summed to arrive at a final commitment score for that partner. This score could range from a low of 4 (if the subject had circled the “1” on each item) to a high of 36 (if the subject had circled the “9” on each item). These scores serve as the dependent variable in your study.

**Manipulating the Independent Variable**

The independent variable in this study is “level of rewards associated with a specific romantic partner.” This independent variable was manipulated by varying the descriptions of the partners shown to the two treatment groups.

The first nine partner descriptions given to the high-reward group were identical to those given to the low-reward group. For partner 10, there was an important difference between the descriptions provided to the two groups. The sheet given to the high-reward group described a relationship with a relatively high level of rewards, but the one given to the low-reward group described a relationship
with a relatively low level of rewards. Below is the description seen by subjects in the high-reward condition:

PARTNER 10: Imagine that you have been dating partner 10 for about a year, and you have put a great deal of time and effort into this relationship. There are not very many attractive members of the opposite sex where you live, so it would be difficult to replace this person with someone else. Partner 10 lives in the same neighborhood as you, so it is easy to see him or her as often as you like. This person enjoys the same recreational activities that you enjoy, and is also very good-looking.

Notice how the preceding description provides information relevant to the four investment model variables discussed earlier. The first sentence provides information dealing with investment size (“...you have put a great deal of time and effort into this relationship.”), and the second sentence deals with alternative value (“There are not very many attractive members of the opposite sex where you live....”). The third sentence indicates that this is a low-cost relationship because “…it is so easy to see him or her as often as you like.” In other words, there are no hardships associated with seeing this partner. If the descriptions said that the partner lives in a distant city, this would have been a high-cost relationship.

However, you are most interested in the last sentence because the last sentence describes the level of rewards associated with the relationship. The relevant sentence is “This person enjoys the same recreational activities that you enjoy, and is also very good-looking.” This statement establishes partner 10 as a high-reward partner for the subjects in the high-reward group.

In contrast, consider the description of partner 10 given to the low-reward group. Notice that it is identical to the description given to the high-reward group with regard to the first three sentences. The last sentence, however, deals with rewards, so this last sentence is different for the low-reward group. It describes a low-reward relationship:
PARTNER 10: Imagine that you have been dating partner 10 for about one year, and you have put a great deal of time and effort into this relationship. There are not very many attractive members of the opposite sex where you live, so it would be difficult to replace this person with someone else. Partner 10 lives in the same neighborhood as you, so it is easy to see him or her as often as you like. This person does not enjoy the same recreational activities that you enjoy, and is not very good-looking.

For this study, the vignette for partner 10 is the only scenario of interest. The analysis is only for the subjects’ ratings of their commitment to partner 10, and disregards their responses to the first nine partners. The first nine partners were included to give the subjects some practice at evaluating commitment before encountering item 10.

Also notice the logic behind these experimental procedures: both groups of subjects are treated in exactly the same way with respect to everything except the independent variable. Descriptions of the first nine partners are identical in the two groups. Even the description of partner 10 is identical with respect to everything except the level of rewards associated with the relationship. Therefore, if the subjects in the high-reward group are significantly more committed to partner 10 than the subjects in the low-reward group, you can be reasonably confident that it is the level of reward manipulation that affected their commitment ratings. It would be difficult to explain the results in any other way.

In summary, you began your investigation with 10 of 20 subjects randomly assigned to the high-reward condition and the other 10 subjects assigned to the low-reward condition. After the subjects complete their task, you disregard their responses to the first nine scenarios, but record their responses to partner 10 and analyze these responses.

**Entering the Data into a JMP Data Table**

Remember that an independent-samples t-test is appropriate for comparing two samples of observations. It allows you to determine whether there is a significant difference between the two samples with respect to the mean scores on their responses. More technically, it allows you to test the null hypothesis that, in the population, there is no difference between the two groups with respect to their mean scores on the response criterion. This section shows how to use the JMP
Bivariate platform to test this null hypothesis for the current fictitious study.

The predictor variable in the study is “level of reward.” This variable can assume one of two values: subjects were either in the high-reward group or in the low-reward group. Because this variable simply codes group membership, you know that it is measured on a nominal scale. In coding the data, you can give subjects a score of “High” if they were in the high-reward condition and a score of “Low” if they were in the low-reward condition. You need a name for this variable, so call it Reward Group.

The response variable in this study is commitment, which is the subjects’ ratings of how committed they would be to a relationship with partner 10. When entering the data, the response is the sum of the rating numbers that have been circled by the subject in responding to partner 10. This variable can assume values from 4 through 36, and is a continuous numeric variable. Call this variable Commitment in the JMP data table.

Figure 7.2 shows the JMP table, commitment difference.jmp, with this hypothetical data. Each line of data contains the group and the commitment response for one subject. Data from the 10 high-reward subjects were keyed first, followed by data from the 10 low-reward subjects. It is not necessary to enter the data sorted this way—data from low-reward and high-reward subjects could have been keyed in a random sequence.

Figure 7.2: Listing of the Commitment Difference JMP Data Table
Performing a \( t \)-Test in JMP

In the previous chapter, the Bivariate platform in JMP (Fit Y by X command) was used to look at measures of association between two continuous numeric variables. Now the Bivariate platform is used to test the relationship between a continuous numeric response variable and a nominal classification (predictor) variable.

\( \checkmark \) To begin the analysis, choose Fit Y by X from the Analyze menu.

\( \checkmark \) Select Commitment from the Select Columns list, and click the Y, Response button.

\( \checkmark \) Select Reward Group in the Select Columns list, and click the X, Factor button. Figure 7.3 shows the completed launch dialog.

Figure 7.3: Launch Dialog for Oneway Platform

Note: At any time, click the Help button to see help for the Oneway (Fit Y by X) platform. Or, choose the question mark (?) tool from the Tools menu or Tools palette, and click on the analysis results.

Results from the JMP Analysis

Click OK on the launch dialog to see the initial results. Figure 7.4 presents the results obtained from the JMP Bivariate platform for a continuous Y variable and a nominal or ordinal X variable. Initially, only the scatterplot of Commitment by Reward Group shows. To see a \( t \)-test, select Means/Anova/Pooled \( t \) from the menu found on the analysis title bar.
Notice that the title of the analysis is Oneway Analysis of Commitment By Reward Group. The Bivariate platform always performs a one-way analysis when the Y (dependent) variable is numeric and the X (independent or predictor) variable is nominal. When the X variable only has two levels, there are two types of independent $t$-test:

- The **Means/Anova/Pooled $t$** gives the $t$-test using the pooled standard error. This option also performs an analysis of variance, which is appropriate if the X variable has more than two levels.

- The **t-Test** menu option tests the difference between two independent groups assuming unequal variances, and therefore uses an unpooled standard error.

The analysis results are divided into sections. The scatterplot shows by default, with the Y variable (Commitment) on the Y axis and the predictor X variable (Reward Group) on the X axis.

The **Means/Anova/Pooled $t$** option overlays *means diamonds*, illustrated above, on the groups in the scatterplot and appends several additional tables to the analysis results.

The means diamonds are a graphical illustration of the $t$-test. If the overlap marks do not vertically separate the groups, as in this example, the groups are probably not significantly different. The groups appear separated if there is vertical space between the top overlap mark of one diamond and the bottom overlap of the other diamond.

The **t Test** report gives the results of the $t$-test for the null hypothesis that the means of the two groups do not differ in the population. The following section describes a systematic approach for interpreting the $t$-test.
To change the markers in the scatterplot from the default small dots:

- Select all rows in the data table.
- Choose the **Markers** command in the **Rows** main menu, and select a different marker from the markers palette.
- Right-click in the scatterplot area and choose the **Marker Size** command. Select the size marker you want from the marker size palette.

**Figure 7.4 Results of t-Test Analysis**

![Oneway Analysis of Commitment By Reward Group](image1.png)

<table>
<thead>
<tr>
<th>Oneway Anova</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Summary of Fit</strong></td>
</tr>
<tr>
<td>R-square</td>
</tr>
<tr>
<td>Adj R-squared</td>
</tr>
<tr>
<td>Root Mean Square Error</td>
</tr>
<tr>
<td>Mean of Response</td>
</tr>
<tr>
<td>Observations (or Sum Wgts)</td>
</tr>
<tr>
<td><strong>t Test</strong></td>
</tr>
<tr>
<td>Assuming equal variances</td>
</tr>
<tr>
<td>Difference</td>
</tr>
<tr>
<td>Std Err Diff</td>
</tr>
<tr>
<td>Upper CL Diff</td>
</tr>
<tr>
<td>Lower CL Diff</td>
</tr>
<tr>
<td>Confidence</td>
</tr>
<tr>
<td><strong>Analysis of Variance</strong></td>
</tr>
<tr>
<td><strong>Means for Oneway Anova</strong></td>
</tr>
<tr>
<td>Level</td>
</tr>
<tr>
<td>Low</td>
</tr>
<tr>
<td>High</td>
</tr>
</tbody>
</table>

Std Error uses a pooled estimate of error variance.
Steps to Interpret the Results

Step 1: Make sure that everything looks reasonable. As stated previously, the name of the nominal-level predictor variable appears on the X axis of the scatterplot, which shows the group values “Low” and “High.” Statistics in the Means for Oneway Anova table show the sample size (Number) for both high-reward and low-reward groups is 10. The mean Commitment score for the high-reward group is 23.3, and the mean score for the low-reward group is 13. The pooled standard error (Std Error) is 0.6587.

You should carefully review each of these figures to verify that they are within the expected range. For example, in this case you know there were no missing values so you want to verify that data for 10 subjects were observed for each group. In addition, you know that the Commitment variable was constructed such that it could assume possible values between 4 and 36. The observed group mean values are within these bounds, so there is no obvious evidence that an error was made keying the data.

Step 2: Review the t statistic and its associated probability value.

The Means/Anova/Pooled t option in this example lets you review the equal-variances t statistics, as noted at the beginning of the t Test table. This t statistic assumes that the two samples have equal variances. In other words, the distribution of scores around the means for both samples is similar.

Descriptive statistics for the difference in the group means are listed on the left in the t Test table in Figure 7.4. The information of interest, on the right in this table, is the obtained t statistic, its corresponding degrees of freedom, and probability values for both one-tailed and two-tailed tests.

- The obtained t statistic (t ratio) is 11.057 (which is quite large).
- This t statistic is associated with 18 degrees of freedom.
- The next item, Prob > |t|, shows that the p-value associated with this t is less than 0.0001. This is the two-sided t-test, which tests the hypothesis that the true difference in means (difference in the population) is neither significantly greater than nor significantly less than the observed difference of 10.3.
But what does this *p*-value (*p* < 0.0001) really mean?

This *p*-value is the probability that you would obtain a *t* statistic as large as 11.057 or larger (in absolute magnitude) if the null hypothesis were true; that is, you would expect to observe an absolute *t* value greater than 11.056 by chance alone in only 1 of 10,000 samples if there were no difference in the population means. If this null hypothesis were true, you expect to obtain a *t* statistic close to zero.

You can state the null hypothesis tested in this study as follows:

“In the population, there is no difference between the low-reward group and the high-reward group with respect to their mean scores on the commitment variable.”

Symbolically, the null hypothesis can be represented

\[ \mu_1 = \mu_2 \text{ or } \mu_1 - \mu_2 = 0 \]

where \( \mu_1 \) is the mean commitment score for the population of people in the high-reward condition, and \( \mu_2 \) is the mean commitment score for the population of people in the low-reward condition.

Remember that, anytime you obtain a *p*-value less than 0.05, you reject the null hypothesis, and because your obtained *p*-value is so small in this case, you can reject the null hypothesis of no commitment difference between groups. You can therefore conclude that there is probably a difference in mean commitment in the population between people in the high-reward condition compared to those in the low-reward condition.

The two remaining items in the *t* Test table are the one-tailed probabilities for the observed *t* value, which tests not only that there is a difference, but also the direction of the difference.

- **Prob > t** is the probability (< 0.0001 in this example) that the difference in population group means is greater than the observed difference.
- **Prob < t** is the probability if (1.0000 in this example) that the difference in population group means is less than the observed difference.
Step 3: Review the graphic for the t-test. The plot to the right in the t Test table illustrates the t-test. The plot is for the t density with 18 degrees of freedom. The obtained t value shows as a red line on the plot. In this case, the t value of 11.057 falls far into the right tail of the distribution, making it easy to see why it is so unlikely that independent samples would produce a higher t than the one shown if the difference between the groups in the population is close to zero.

Step 4: Review the sample means. The significant t statistic indicates that the two populations are probably different from each other. The low-reward group has a mean score of 13.0 on the commitment scale, and the high-reward group has a mean score of 23.3. It is therefore clear that, as you expected, the high-reward group demonstrates a higher level of commitment compared to the low-reward group.

Step 5: Review the confidence interval for the difference between the means. A confidence interval extends from a lower confidence limit to an upper confidence limit. The t Test table in Figure 7.4 (also shown here) gives the upper confidence limit of the difference, Upper CL Dif, of 12.2571, and the lower confidence limit of the difference, Lower CL Dif, of 8.3429. Thus, the 95% confidence interval for the difference between means extends from 12.2571 to 8.3429.

This means you can estimate with a 95% probability that in the population, the actual difference between the mean of the low-reward condition and the mean of the high-reward condition is somewhere between 12.2571 and 8.3429. Notice that this interval does not contain the value of zero (difference). This is consistent with your rejection of the null hypothesis, which states:

“In the population, there is no difference between the low-reward and high-reward groups with respect to their mean scores on the commitment variable.”

Step 6: Compute the index of effect size. In this example, the p-value is less than the standard criterion of .05 so you reject the null hypothesis. You know that there is a statistically significant difference between the observed commitment
levels for the high-reward and low-reward conditions. But is it a relatively large difference? The null hypothesis test alone does not tell whether the difference is large or small. In fact, with very large samples you can obtain statistically significant results even if the difference is relatively trivial.

Because of this limitation of null hypothesis testing, many researchers now supplement statistics such as *t*-tests with measures of effect size. The exact definition of effect size varies depending on the type of analysis. For an independent samples *t*-test, *effect size* can be defined as the degree to which one sample mean differs from a second sample mean stated in terms of standard deviation units. That is, it is the absolute value of the difference between the group means divided by the pooled estimate of the population standard deviation.

The formula for effect size, denoted *d*, is

\[
d = \frac{|\bar{X}_1 - \bar{X}_2|}{s_p}
\]

where

- \( \bar{X}_1 \) = the observed mean of sample 1 (the participants in treatment condition 1)
- \( \bar{X}_2 \) = the observed mean of sample 2 (the participants in treatment condition 2)
- \( s_p \) = the pooled estimate of the population standard deviation

To compute the formula, use the sample means from the Means for Oneway Anova table, discussed previously. The estimate of the population standard deviation is the Root Mean Square Error found in the Summary of Fit table of the *t*-test analysis gives the pooled estimate of the population standard deviation (see Figure 7.4).

\[
d = \frac{|23.3 - 13.0|}{2.083} = 4.9448
\]
This result tells you that the sample mean for the low-reward condition differs from the sample mean for the high-reward condition by 4.9448 standard deviations. To determine whether this is a relatively large or small difference, you can consult the guidelines provided by Cohen (1992), which are shown in Table 7.1.

**Table 7.1: Guidelines for Interpreting t-Test Effect Sizes**

<table>
<thead>
<tr>
<th>Effect Size</th>
<th>Computed d Statistic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small effect</td>
<td>$d = 0.20$</td>
</tr>
<tr>
<td>Medium effect</td>
<td>$d = 0.50$</td>
</tr>
<tr>
<td>Large effect</td>
<td>$d = 0.80$</td>
</tr>
</tbody>
</table>

The computed $d$ statistic of 4.9448 for the commitment study is larger than the large-effect value in Table 7.1. This means that the differences between the low-reward and high-reward participants in commitment levels for partner 10 produced both a statistically significant and a very large effect.

**General Outline for Summarizing Analysis Results**

In performing an independent-samples $t$-test (and other analyses), the following format can be used to summarize the research problem and results:

A. Statement of the problem
B. Nature of the variables
C. Statistical test
D. Null hypothesis ($H_0$)
E. Alternative hypothesis ($H_1$)
F. Obtained statistic
G. Obtained probability $p$-value
H. Conclusion regarding the null hypothesis
I. Sample means and confidence interval of the difference
J. Effect size
K. Figure representing the results
L. Formal description of results for a paper
The following is a summary of the preceding example analysis according to this format.

**A. Statement of the problem**

The purpose of this study was to determine whether there is a difference between people in a high-reward relationship and those in a low-reward relationship with respect to their mean commitment to the relationship.

**B. Nature of the variables**

This analysis involved two variables. The predictor variable was level of rewards, which was measured on a nominal scale and could assume two values: a low-reward condition (coded as “Low”) and a high-reward condition (coded as “High”). The response variable was commitment, which was a numeric continuous variable constructed from responses to a survey with values ranging from 4 through 36.

**C. Statistical test**

Independent-samples $t$-test, assuming equal variances.

**D. Null hypothesis ($H_0$)**

$\mu_1 = \mu_2$. In the population, there is no difference between people in a high-reward relationship and those in a low-reward relationship with respect to their mean levels of commitment.

**E. Alternative hypothesis ($H_1$)**

$\mu_1 \neq \mu_2$. In the population, there is a difference between people in a high-reward relationship and those in a low-reward relationship with respect to their mean levels of commitment.

**F. Obtained statistic**

$t = 11.057$.

**G. Obtained probability $p$-value**

$p < .0001$.

**H. Conclusion regarding the null hypothesis**

Reject the null hypothesis.
I. Sample means and confidence interval of the difference
The difference between the high-reward and the low-reward means was 23.3 – 13 = 10.3. The 95% confidence interval for this difference extended from 8.3429 to 12.2571.

J. Effect size
d = 4.94 (large effect size).

K. Figure representing the results
To produce the chart shown here:

☐ Choose Chart command from the Graph menu.

☐ Select Reward Group as X. Select Commitment and choose Mean from the statistics menu as Y, and then click OK.

☐ From the red triangle menu on the Chart title bar, choose Label Options > Show Labels.

L. Formal description of results for a paper
Most chapters in this book show you how to summarize the results of an analysis in a way that would be appropriate if you were preparing a paper to be submitted for publication in a scholarly research journal. These summaries generally follow the format recommended in the Publication Manual of the American Psychological Association (2009), which is required by many journals in the social sciences.
Here is an example of how the current results could be summarized according to this format:

Results were analyzed using an independent-samples \( t \)-test. This analysis revealed a significant difference between the two groups: \( t \) (18) = 11.05689; \( p < 0.0001 \). The sample means are displayed with a bar chart, which illustrates that subjects in the high-reward condition scored significantly higher on commitment than did subjects in the low-reward condition (for high-reward group, Mean = 23.30, SD = 1.95; for low-reward group, Mean = 13.00, SD = 2.21). The observed difference between means was 10.30, and the 95% confidence interval for the difference between means extended from 8.34 to 12.26. The effect size was computed as \( d = 4.94 \). According to Cohen’s (1992) guidelines for \( t \)-tests, this represents a large effect.

**Example with Nonsignificant Differences**

Researchers do not always obtain significant results when performing investigations such as the one described in the previous section. This section repeats the analyses, this time using fictitious data that result in a nonsignificant \( t \)-test. The conventions for summarizing nonsignificant results are then presented.

The data table for the following example is commitment no difference.jmp. The data have been modified so that the two groups do not differ significantly on mean levels of commitment. Figure 7.5 shows this JMP table. Simply “eyeballing” the data reveals that similar commitment scores seem to be displayed by subjects in the two conditions. Nonetheless, a formal statistical test is required to determine whether significant differences exist.

**Figure 7.5: Example Data for Nonsignificant \( t \)-Test**
Proceed as before.

- Use **Analyze > Fit Y by X** (see Figure 7.3).
- When the results appear, select the **Means/Anova/Pooled t** from the menu on the analysis title bar (see Figure 7.4).
- Also select the **Means and Std Dev** option, as illustrated in Figure 7.6. This option shows the pooled standard deviation used to compute $t$ values in this example and in the previous example.

**Figure 7.6: Results of Analysis with Nonsignificant $t$-Test**

The $t$ Test table in Figure 7.6 shows the $t$ statistic (assuming equal variances) to be small at 0.627 and $p$-value for this $t$ statistic is large at 0.5380. Because this $p$-value is greater than the standard cutoff of 0.05, you can say that the $t$ statistic is not significant. These results mean that you don’t reject the null hypothesis of equal population means on commitment. In other words, you conclude that there is not a significant difference between mean levels of commitment in the two samples.

This analysis shows the Means and Std Deviations table for the data, which gives the **Std Dev** and **Std Error Mean** for each level of the Commitment variable. Note that, as before, the **Std Error** value in the Means for Oneway Anova table is the
same for both levels because the pooled error is used in the $t$-test computations. The mean commitment score is 23.3 for the high-reward group and 22.7 for the low-reward group. The $t$ Test table shows the difference between the means is 0.6 with lower confidence limit of −1.4078 and upper confidence limit of 2.6078. Notice that this interval includes zero, which is consistent with your finding that the difference between means is not significant (or, say the difference is not significantly different than zero).

Compute the effect size of the difference as the difference between the means divided by the estimate of the standard deviation of the population (Root Mean Square Error in the Summary of Fit table):

$$d = \frac{X_1 - X_2}{s_p}$$

$$d = \frac{23.3 - 22.7}{2.137} = 0.2808$$

Thus the index of effect size for the current analysis is 0.2802. According to Cohen’s guidelines in Table 7.1, this value falls between a small and medium effect.

For this analysis, the statistical interpretation format appears as follows. This is the same study as shown previously so you can complete items A through E in the same way.

**F. Obtained statistic**

$t = 0.6278$.

**G. Obtained probability p-value**

$p = 0.5380$.

**H. Conclusion regarding the null hypothesis**

Fail to reject the null hypothesis.

**I. Sample means and confidence interval of the difference**

The difference between the high-reward and the low-reward means was 23.3 – 22.7 = 0.6. The 95% confidence interval for this difference extended from −1.4078 to 2.6078.
J. Effect size

\[ d = 0.2808 \] (small to medium effect size)

K. Figure representing the results

To produce the chart shown here:

- Choose Chart command in the Graph menu.
- Select Reward Group as X. Select Commitment and choose Mean from the statistic menu as Y, then click OK.
- Then, from the red triangle menu on the Chart title bar, choose Label Options > Show Labels.

L. Formal description of results for a paper

The following is an example of a formal description of the results.

Results were analyzed using an independent-samples \( t \)-test. This analysis failed to reveal a significant difference between the two groups, \( t(18) = 0.628 \) giving \( p = 0.538 \). The bar chart of the sample means illustrate that subjects in the high-reward condition demonstrated scores on commitment that were similar to those shown by subjects in the low-reward condition (for high-reward group, Mean = 23.30, SD = 1.95; for low-reward group, Mean = 22.70, SD = 2.31). The observed difference between means was 0.6 and the 95\% confidence interval for the difference between means extended from –1.41 to 2.61. The effect size was computed as \( d = 0.28 \). According to Cohen’s (1992) guidelines for \( t \)-tests, this represents a small to medium effect.

The Paired-Samples \( t \)-Test

The paired-samples \( t \)-test (sometimes called the correlated-samples \( t \)-test or matched-samples \( t \)-test) is similar to the independent-samples test in that both procedures compare two samples of observations, and determine whether the mean of one sample is significantly differs from than the mean of the other. With the independent-samples procedure, the two groups of scores are completely
independent. That is, an observation in one sample is not related to any observation in the other sample. Independence is achieved in experimental research by drawing a sample of subjects and randomly assigning each subject to either condition 1 or condition 2. Because each subject contributes data under only one condition, the two samples are empirically independent.

In contrast, each score in one sample of the paired-samples procedure is paired in some meaningful way with a score in the other sample. There are several ways that this can happen. The following examples illustrate some of the most common paired situations.

Examples of Paired-Samples Research Designs

Be aware that the following fictitious studies illustrate paired sample designs, but might not represent sound research methodology from the perspective of internal or external validity. Problems with some of these designs are reviewed later.

Each Subject Is Exposed to Both Treatment Conditions

Earlier sections described an experiment in which level of reward was manipulated to see how it affected subjects’ level of commitment to a romantic relationship. The study required that each subject review 10 people and rate commitment to each fictitious romantic partner. The dependent variable is the rated amount of commitment the subjects displayed toward partner 10. The independent variable is manipulated by varying the description of partner 10: subjects in the “high-reward” condition read that partner 10 had positive attributes, while subjects in the “low-reward” condition read that partner 10 did not have these attributes. This study is an independent-samples study because each subject was assigned to either a high-reward condition or a low-reward condition (but no subject was ever assigned to both conditions).

You can modify this (fictitious) investigation so that it follows a paired-samples research design by conducting the study with only one group of subjects instead of two groups. Each subject rates partner 10 twice, once after reading the low-reward version of partner 10, and a second time after reading the high-reward version of partner 10.
It would be appropriate to analyze the data resulting from such a study using the paired-samples t-test because it is possible to meaningfully pair observations under the both conditions. For example, subject 1’s rating of partner 10 under the low-reward condition can be paired with his or her rating of partner 10 under the high-reward condition, subject 2’s rating of partner 10 under the low-reward condition could be paired with his or her rating of partner 10 under the high-reward condition, and so forth. Table 7.2 shows how the resulting data could be arranged in tabular form.

Remember that the dependent variable is still the commitment ratings for partner 10. Subject 1 (John) has two scores on this dependent variable—a score of 11 obtained in the low-reward condition, and a score of 19 obtained in the high-reward condition. John’s score in the low-reward condition is paired with his score from the high-reward condition. The same is true for the remaining participants.

Table 7.2: Fictitious Data from a Study Using a Paired Samples Procedures

<table>
<thead>
<tr>
<th></th>
<th>Low-Reward Condition</th>
<th>High-Reward Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>11</td>
<td>19</td>
</tr>
<tr>
<td>Mary</td>
<td>9</td>
<td>22</td>
</tr>
<tr>
<td>Tim</td>
<td>10</td>
<td>23</td>
</tr>
<tr>
<td>Susan</td>
<td>9</td>
<td>18</td>
</tr>
<tr>
<td>Maria</td>
<td>12</td>
<td>21</td>
</tr>
<tr>
<td>Fred</td>
<td>12</td>
<td>25</td>
</tr>
<tr>
<td>Frank</td>
<td>17</td>
<td>22</td>
</tr>
<tr>
<td>Edie</td>
<td>15</td>
<td>25</td>
</tr>
<tr>
<td>Jack</td>
<td>14</td>
<td>24</td>
</tr>
<tr>
<td>Shirley</td>
<td>19</td>
<td>31</td>
</tr>
</tbody>
</table>

**Matching Subjects**

The preceding study used a type of repeated measures approach. There is only one sample of participants, and repeated measurements on the dependent variable (commitment) are taken from each participant. That is, each person contributes one score under the low-reward condition and a second score under the high-reward condition.
A different approach could have used a type of matching procedure. With a matching procedure, a given participant provides data under only one experimental condition. However, each person is matched with certain conditions to a different person who provides data under the other experimental condition:

- The participants are matched on some variable that is expected to be related to the dependent variable.
- The matching is done prior to the manipulation of the independent variable.

For example, imagine that it is possible to administer an emotionality scale to subjects. Further, prior research has shown that scores on this scale are strongly correlated with scores on romantic commitment (the dependent variable in your study). You could administer this emotionality scale to 20 participants, and use their scores on that scale to match them. That is, you could place them in pairs according to their similarity on the emotionality scale.

Now suppose scores on the emotionality scale range from a low of 100 to a high of 500. Assume that John scores 111 on this scale, and William scores 112. Because their scores are very similar, you pair them together, and they become subject pair 1. Tim scores 150 on this scale, and Fred scores 149. Because their scores are very similar, you also pair them together as subject pair 2. Table 7.3 shows how you could arrange these fictitious pairs of subjects.

Within a subject pair, one participant is randomly assigned to the low-reward condition, and one is assigned to the high-reward condition. Assume that, for each of the pairs in Table 7.3, the person listed first was randomly assigned to the low-reward condition, and the person listed second was assigned to the high-reward condition. The study then proceeds in the usual way, with subjects rating the various paper people.
Table 7.3 shows that, for Subject pair 1, John gave a commitment score of 8 to partner 10 in the low-reward condition; William gave a commitment score of 19 to partner 10 in the high-reward condition. When analyzing the data, you pair John’s score on the commitment variable with William’s score on commitment. The same will be true for the remaining subject pairs. A later section shows how to analyze the data using JMP.

Remember that subjects are placed together in pairs on the basis of some matching variable before the independent variable is manipulated. The subjects are not placed together in pairs on the basis of their scores on the dependent variable. In the present case, subjects are paired based on the similarity of their scores on the emotionality scale that was administered previously. Later, the independent variable is manipulated and the subjects’ commitment scores are recorded. Although they are not paired on the basis of their scores on the dependent variable...
variable, you hope that their scores on the dependent variable will be correlated. There is more discussion on this in a later section.

**Take Pretest and Posttest Measures**
Consider now a different type of research problem. Assume that an educator believes that taking a foreign language course causes an improvement in critical thinking skills among college students. To test the hypothesis, the educator administers a test of critical thinking skills to a single group of college students at two points in time:

- A pretest is administered at the beginning of the semester (prior to taking the language course).
- A posttest is administered at the end of the semester (after completing the course).

The data obtained from the two test administrations appear in Table 7.4.

**Table 7.4: Fictitious Data from Study Using a Pretest-Posttest Procedure**

<table>
<thead>
<tr>
<th>Subject</th>
<th>Pretest</th>
<th>Posttest</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>34</td>
<td>55</td>
</tr>
<tr>
<td>Mary</td>
<td>35</td>
<td>49</td>
</tr>
<tr>
<td>Tim</td>
<td>39</td>
<td>59</td>
</tr>
<tr>
<td>Susan</td>
<td>41</td>
<td>63</td>
</tr>
<tr>
<td>Maria</td>
<td>43</td>
<td>62</td>
</tr>
<tr>
<td>Fred</td>
<td>44</td>
<td>68</td>
</tr>
<tr>
<td>Frank</td>
<td>44</td>
<td>69</td>
</tr>
<tr>
<td>Edie</td>
<td>52</td>
<td>72</td>
</tr>
<tr>
<td>Jack</td>
<td>55</td>
<td>75</td>
</tr>
<tr>
<td>Shirley</td>
<td>57</td>
<td>78</td>
</tr>
</tbody>
</table>

You can analyze these data using the paired-samples $t$-test because it is meaningful to pair the same subject’s pretest and posttest scores. When the data are analyzed, the results indicate whether there was a significant increase in critical thinking scores over the course of the semester.
Problems with the Paired Samples Approach

Some of the studies described in the preceding section use fairly weak experimental designs. This means that, even if you had conducted the studies, you might not have been able to draw firm conclusions from the results because alternative explanations could be offered for those results.

Order Effects
Consider the first investigation that exposes each subject to both the low-reward version of partner 10 as well as the high-reward version of partner 10. If you designed this study poorly, it might suffer from confoundings that make it impossible to interpret the results. For example, suppose you design the study so that each subject rates the low-reward version first and the high-reward version second? If you then analyze the data and find that higher commitment ratings were observed for the high-reward condition, you would not know whether to attribute this finding to the manipulation of the independent variable (level of rewards) or to order effects. Order effects are the possibility that the order in which the treatments were presented influenced scores on the dependent variable. In this example it is possible that subjects tend to give higher ratings to partners that are rated later in serial order. If this is the case, the higher ratings observed for the high-reward partner may simply reflect such an order effect.

Alternative Explanations
The third study, which investigated the effects of a language course on critical thinking skills, also displays a weak experimental design. The single-group pretest-posttest design assumes you administered the test of critical thinking skills to the students at the beginning and again at the end of the semester. It further assumes that you observe a significant increase in their skills over this period as would be consistent with your hypothesis that the foreign language course helps develop critical thinking skills.

However, there are other reasonable explanations for the findings. Perhaps the improvement was simply due to the process of maturation—changes that naturally take place as people age. Perhaps the change is due to the general effects of being in college, independent of the effects of the foreign language
Because of the weak design used in this study, you will probably never be able to draw firm conclusions about what was really responsible for the students’ improvement.

This is not to argue that researchers should never obtain the type of data that can be analyzed using the paired-samples $t$-test. For example, the second study described previously (the matching procedure) was reasonably sound and might have provided interpretable results. The point here is that research involving paired-samples must be designed very carefully to avoid the sorts of problems discussed here. You can deal with most of these difficulties through the appropriate use of counterbalancing, control groups, and other strategies. The problems inherent in repeated measures and matching designs, along with the procedures that can be used to handle these problems, are discussed in Chapter 11, *One-Way ANOVA with One Repeated-Measures Factor*, and Chapter 12, *Factorial ANOVA with Repeated-Measures Factors and Between-Subjects Factors*.

**When to Use the Paired Samples Approach**

When conducting a study with only two treatment conditions, you often have the choice of using either the independent-samples approach or the paired-samples approach. One of the most important considerations is the extent to which the paired-samples analysis can result in a more sensitive test. That is, to what extent is the paired-samples approach more likely to detect significant differences when they actually do exist?

It is important to understand that the paired-samples $t$-test has one important weakness in regard to sensitivity—it has only half the degrees of freedom as the equivalent independent-samples test. Because the paired-samples approach has fewer degrees of freedom, it must display a larger $t$-value than the independent-samples $t$-test to attain statistical significance.

However, under the right circumstances, the paired-samples approach results in a smaller standard error of the mean (the denominator in the formula used to compute the $t$ statistic, and a smaller standard error usually results in a more sensitive test. The exception is that the paired-samples approach results in a smaller standard error only if scores on the two sets of observations are positively correlated with one another. This concept is easiest to understand with reference to the pretest-posttest study shown in Table 7.3.
Notice that scores on the pretest appear to be positively correlated with scores on the posttest. That is, subjects who obtained relatively low scores on the pretest (such as John) also tended to obtain relatively low scores on the posttest. Similarly, subjects who obtained relatively high scores on the pretest (such as Shirley) also tended to obtain relatively high scores on the posttest. This shows that although the subjects might have displayed a general improvement in critical thinking skills over the course of the semester, their ranking relative to one another remained relatively constant. The subjects with the lowest scores at the beginning of the term still tended to have the lowest scores at the end of the term.

The situation described here is the type of situation that makes the paired-samples \( t \)-test the optimal procedure. Because pretest scores are correlated with posttest scores, the paired-samples approach should yield a fairly sensitive test.

The same logic applies to the other studies described previously. For example, look at the values in Table 7.2, from the study in which subjects were assigned to pairs based on matching criteria. There appears to be a correlation between scores obtained in the low-reward condition and those obtained in the high-reward condition. This could be because subjects were first placed into pairs based on the similarity of their scores on the emotionality scale, and the emotionality scale is predictive of how subjects respond to the commitment scale. For example, both John and William (pair 1) display relatively low scores on commitment, presumably because they both scored low on the emotionality scale that was initially used to match them. Similarly, both George and Dave (subject pair 10) scored relatively high on commitment, presumably because they both scored high on emotionality.

This illustrates why it is so important to select relevant matching variables when using a matching procedure. There is a correlation between the two commitment variables above because (presumably) emotionality is related to commitment. If you had instead assigned subjects to pairs based on some variable that is not related to commitment (such as subject shoe size), the two commitment variables would not be correlated, and the paired-samples \( t \)-test would not provide a more sensitive test. Under those circumstances, you achieve more power by instead using the independent-samples \( t \)-test and capitalizing on the greater degrees of freedom.
An Alternative Test of the Investment Model

The remainder of this chapter shows how to use JMP to perform paired-sample \( t \)-tests, and describes how to interpret the results. The first example is based on the fictitious study that investigates the effect of levels of reward on commitment to a romantic relationship. The investigation included 10 subjects, and each subject rated partner 10 after reviewing the high-reward version of partner 10, and again after reviewing the low-reward version. Figure 7.7 shows the data keyed into a JMP data table called commitment paired.jmp.

Figure 7.7: Paired Commitment Data

Notice in the JMP table that the data are arranged exactly as they were presented in Table 7.2. The two score variables list commitment ratings obtained when subjects reviewed the low-reward version of partner 10 (Low Reward), and when they reviewed the high-reward version of partner 10 (High Reward).

It is easy to do a paired \( t \)-test in JMP.

- Choose the **Matched Pairs** command from the **Analyze** menu.
- When the launch dialog appears, select the Low Reward and the High Reward variables (the set of paired responses) and click the **Y, Paired Response** button to enter them as the paired variables to be analyzed.
- Click **OK** to see the results in Figure 7.8.
Interpret the Paired t Plot

Like most JMP analyses, the results start with a graphic representation of the analysis. The illustration here describes the paired t-test plot, using y1 and y2 as the paired variables. The vertical axis is the difference between the group means, with a zero line that represents zero difference between means. If the dotted 95% confidence lines (around the plotted difference) also encompass the zero reference, then you visually conclude there is no difference between group means. In Figure 7.8, the mean difference and its confidence lines are far away from the zero reference so you can visually conclude there is a difference between groups.

Note: The diamond-shaped rectangle on the plot results from the Reference Frame option found in the red triangle menu on the Matched Pairs title bar.
Interpret the Paired t Statistics

The Matched Pairs report lists basic summary statistics. You can see that the mean commitment score in the low-reward condition is 12.8, and the mean commitment score in the high-reward condition is 23.0. Subjects displayed higher levels of commitment for the high-reward version of partner 10.

Also note in the Matched Pairs report that the lower 95% confidence limit (Lower95%) is 8.3265, and the upper limit (Upper95%) is 12.0715. This lets you estimate with 95% probability that the actual difference between the mean of the low-reward condition and the mean of the high-reward condition (in the population) is between these two confidence limits. Also, as shown in the plot above, this interval does not contain zero, which indicates you will be able to reject the null hypotheses. If there was no difference between group means, you expect the confidence interval to include zero (a difference score of zero).

Note that the Mean Difference is 10.2, and the standard error of the difference is 0.82731. The paired \( t \) analysis determines whether this mean difference is significantly different from zero. Given the way that this variable was created, a positive value on this difference indicates that, on the average, scores for High Reward tended to be higher than scores for Low Reward. The direction of this difference is consistent with your prediction that higher rewards are associated with greater levels of commitment.

Next, review the results of the \( t \)-test to determine whether this mean difference score is significantly different from zero. The \( t \) statistic in a paired-samples \( t \)-test is computed using the following formula:

\[
t = M_d / SE_d
\]

where

\[
M_d = \text{the mean difference score}
\]

\[
SE_d = \text{the standard error of the mean for the difference scores (the standard deviation of the sampling distribution of means of difference scores)}
\]
This $t$-value in this example is obtained by dividing the mean difference score of 10.2 by the standard error of the difference (0.82731 shown in the results table), giving $t = 12.32909$. Your hypothesis is one-sided—you expect high reward groups to have significantly higher commitment scores. Therefore, the probability of getting a greater positive $t$-value shows as $\text{Prob} > t$ and is less than 0.0001. This $p$-value is much lower than the standard cutoff of 0.05, which indicates that the mean difference score of 10.2 is significantly greater than zero. Therefore you can reject the null hypothesis that the population difference score was zero, and conclude that the mean commitment score of 23.0 observed with the high-reward version of partner 10 is significantly higher than the mean score of 12.8 observed with low-reward version of partner 10. In other words, you tentatively conclude that the level of reward manipulation had an effect on rated commitment.

The degrees of freedom associated with this $t$-test are $N - 1$, where $N$ is the number of pairs of observations in the study. This is analogous to saying that $N$ is equal to the number of difference scores that are analyzed. If the study involves taking repeated measures from a single sample of subjects, $N$ will be equal to the number of subjects. However, if the study involves two sets of subjects who are matched to form subject pairs, $N$ will be equal to the number of subject pairs, which is one-half the total number of subjects.

The present study involved taking repeated measures from a single sample of 10 participants. Therefore, $N = 10$ in this study, and the degrees of freedom are $10 - 1 = 9$, as in the $t$-test results shown in Figure 7.8.

**Effect Size of the Result**

The previous example in this chapter defined effect size, $d$, as the degree to which a mean score obtained under one condition differs from the mean score obtained under a second condition. For the paired $t$-test, the $d$ statistic is computed by dividing the difference between the means by the estimated standard deviation of the population of difference scores. That is,

$$d = \frac{\bar{X}_1 - \bar{X}_2}{s_d}$$
where

\[ \bar{X}_1 = \text{the observed mean of sample 1 (the participants in treatment condition 1)} \]

\[ \bar{X}_2 = \text{the observed mean of sample 2 (the participants in treatment condition 2)} \]

\[ s_d = \text{the estimated standard deviation of the population of difference scores} \]

The Paired \( t \) Test report does not show \( s_d \) but it is computed as the standard error (Std Err), shown in the \( t \) Test Analysis report, multiplied by the square root of the sample size (N). That is,

\[ s_d = (\text{Std Err} \times \sqrt{N}) = (0.82731 \times \sqrt{10}) = (0.82731 \times 3.162) = 2.616 \]

Then \( d \) is computed,

\[ d = \frac{|\bar{X}_1 - \bar{X}_2|}{s_d} = \frac{|23 - 12.8|}{2.616} = \frac{10.2}{2.616} = 3.999 \]

Thus, the obtained index of effect size for the current study is 3.999, which means the commitment score under the low-reward condition differs from the mean commitment score under the high-reward condition by almost four standard deviations. To determine whether this is a large or small difference, refer to the guidelines provided by Cohen (1992), which are shown in Table 7.1. Your obtained \( d \) statistic of 3.999 is much larger than the “large effect” value of 0.80. This means that the manipulation in your study produced a very large effect.

**Summarize the Results of the Analysis**

One way to produce a summary bar chart is to stack the paired commitment scores in the two reward columns into a single column, and use the Chart platform to plot the means of the reward groups. The example in Chapter 3, “Working with JMP Data,” uses this paired data to show how to stack columns. With the Commitment Paired data table active,

- Choose **Stack** from the **Tables** menu.
Select the Low Reward and High Reward variables and click Add to add them to the Stack Columns list, as shown in Figure 7.9.

Uncheck the Stack by Row box on the dialog, which is checked by default.

Figure 7.9: Stack Dialog to Stack Commitment Scores into a Single Column

Choose Graph > Chart, complete the Chart dialog as in Figure 7.10, and then click OK.

You should now see the data table shown on the left in Figure 7.11. This data table with stacked columns is now in the same form as the one shown previously in Figure 7.5, used to illustrate the independent samples $t$-test.

Figure 7.10: Completed Chart Dialog to Chart Mean Commitment Scores

From the red triangle menu on the Chart title bar, choose Label Options > Show Labels to show the mean commitment value on each bar.

Experiment with other options on the Chart menu to see what they do.
You can summarize the results of the present analysis following the same format used with the independent group’s *t*-test, as presented earlier in this chapter.

Results were analyzed using a paired-samples *t*-test. This analysis revealed a significant difference between mean levels of commitment observed in the two conditions, *t* (9) = 12.32 and *p* < 0.0001. The sample means are displayed as a bar chart in Figure 7.11, which shows that mean commitment scores appear significantly higher in the high-reward condition (mean = 23) than in the low-reward condition (mean = 12.8). The observed difference between these scores was 10.2, and the 95% confidence interval for the difference extended from 8.3285 to 12.0715. The effect size was computed as *d* = 3.999. According to Cohen’s (1992) guidelines for *t*-tests, this represents a very large effect.

**A Pretest-Posttest Study**

A previous section presented the hypothesis that taking a foreign language course leads to an improvement in critical thinking among college students. To test this hypothesis, assume that you conducted a study in which a single group
of college students took a test of critical thinking skills both before and after completing a semester-long foreign language course. The first administration of the test constituted the study’s pretest, and the second administration constituted the posttest. The JMP data table, `languagetext.jmp`, which is shown on the left in Figure 7.12, has the results of the study.

Analyze the data using the same approach shown in the previous example.

1. Choose the **Matched Pairs** command from the **Analyze** menu.
2. When the launch dialog appears, select **Pretest** (each participant’s score on the pretest) and **Posttest** (each participant’s score on the posttest), and click the **Y, Paired Response** button to enter them as the pair of variables to be analyzed.
3. Click **OK** to see the results in Figure 7.12.

**Figure 7.12: Data for Pretest and Posttest Language Scores**

The positive mean difference in score (Posttest–Pretest) is consistent with the hypothesis that taking a foreign language course causes an improvement in critical thinking. You can interpret the results in the same manner as the previous example. This analysis reveals a significant difference between mean levels of pretest scores and posttest scores, with

\[ t(9) = 21.7951 \text{ and } p < 0.0001. \]
Summary

The t-test is one of the most commonly used statistics in the social sciences, in part because some of the simplest investigations involve the comparison of just two treatment conditions. When an investigation involves more than two conditions, however, the t-test is no longer appropriate, and you usually replace it with the $F$ test obtained from an analysis of variance (ANOVA). The simplest ANOVA procedure—the one-way ANOVA with one between-subjects factor—is the topic of the next chapter.

Appendix: Assumptions Underlying the $t$-Test

Assumptions Underlying the Independent-Samples $t$-Test

**Level of measurement**

The response variable should be assessed on an interval- or ratio-level of measurement. The predictor variable should be a nominal-level variable that must include two categories (groups).

**Independent observations**

A given observation should not be dependent on any other observation in either group. In an experiment, you normally achieve this by drawing a random sample and randomly assigning each subject to only one of the two treatment conditions. This assumption would be violated if a given subject contributed scores on the response variable under both treatment conditions. The independence assumption is also violated when one subject’s behavior influences another subject’s behavior within the same condition. The texts discussed in this chapter rely on the assumption of independent observations. If this assumption is not met, inferences about the population (results of hypothesis tests) can be misleading or incorrect.

**Random sampling**

Scores on the response variable should represent a random sample drawn from the populations of interest.
Normal distributions
Each sample should be drawn from a normally distributed population. If each sample contains over 30 subjects, the test is robust against moderate departures from normality.

Homogeneity of variance
To use the equal-variances $t$-test, you should draw the samples from populations with equal variances on the response variable. If the null hypothesis of equal population variances is rejected, you should use the unequal-variances $t$-test.

Assumptions Underlying the Paired-Samples $t$-Test

Level of measurement
The response variable should be assessed on an interval-l or ratio-level of measurement. The predictor variable should be a nominal-level variable that must include just two categories.

Paired observations
A given observation appearing in one condition must be paired in some meaningful way with a corresponding observation appearing in the other condition. You can accomplish this by having each subject contribute one score under condition 1, and a separate score under condition 2. Observations can also be paired by using a matching procedure to create the sample.

Independent observations
A given subject’s score in one condition should not be affected by any other subject’s score in either of the two conditions. It is acceptable for a given subject’s score in one condition to be dependent upon his or her own score in the other condition. This is another way of saying that it is acceptable for subjects’ scores in condition 1 to be correlated with their scores in condition 2.

Random sampling
Subjects contributing data should represent a random sample drawn from the populations of interest.
**Normal distribution for difference scores**

The differences in paired scores should be normally distributed. These difference scores are usually created by beginning with a given subject’s score on the dependent variable obtained under one treatment condition and subtracting from it that subject’s score on the dependent variable obtained under the other treatment condition. It is not necessary that the individual dependent variables be normally distributed, as long as the distribution of difference scores is normally distributed.

**Homogeneity of variance**

The populations represented by the two conditions should have equal variances on the response criterion.

**References**


Index

A

absolute value of coefficient 133
actual by predicted leverage plot 276–278, 456
Actual by Predicted leverage plot 276–278, 456
Actual by Predicted Plot table 456
Add Columns command (Cols menu) 89
Add Multiple Columns command
Cols menu 53, 55, 175
Add Rows command (Rows menu) 53, 56
Add Rows dialog box 56
aggression study
in factorial ANOVA 257–268
in MANOVA with between-subjects factor 298–300
in one-way ANOVA 227–231
R2 statistic in 230–231
alternative hypotheses
described 23
directional 24–25
nondirectional 23–25
test of association and 24–25
test of group differences and 23–24
Analysis of Variance report 311–312
Analysis of Variance table
factorial ANOVA with between-subjects factor 279, 293
multiple regression analysis 456
one-way ANOVA with between-subjects factor 240–242, 248–249
Analyze menu 35, 213, 220
analyzing data
See data analysis
ANOVA (analysis of variance)
Analysis of Variance report 311–312
Analysis of Variance table
factorial ANOVA with between-subjects factor 279, 293
multiple regression analysis 456
one-way ANOVA with between-subjects factor 240–242, 248–249
Analyze menu 35, 213, 220
analyzing data
See data analysis
ANOVA (analysis of variance)
described 128–129
factorial with between-subjects factor 255–296
MANOVA similarities to 298–299
multiple regression and 412
naturally occurring variables and 415
one-way with between-subjects factor 225–254
ANOVA Summary table
factorial ANOVA with between-subjects factor 281–282, 284
mixed-design ANOVA 390
one-way ANOVA with between-subjects factor 242–243
one-way ANOVA with repeated-measures factor 336–337
approximately normal distribution 102
association, measures of
alternative hypothesis and 24–25
described 21–22, 123–124
null hypothesis and 24–25
B
bar charts
labeling 218–219, 247, 330–331
producing 204
Best data format 58
Beta weights 461–462
between-subjects designs
assumptions for 406–408
factorial ANOVA 255–296, 357–408
group effect in 389–390
MANOVA 297–320
mixed-design ANOVA and 359
one-way ANOVA 225–254
repeated-measures designs versus 228, 323, 338–342
Beveled option (Analysis of Variance table) 240
bivariate association
assumptions underlying 161–162
chi-square test of independence 148–158
choosing correct statistic 124–129
described 123–124
Fisher's exact test 159–160
Multivariate platform 139–148, 451
Pearson correlations 130–146
Spearman correlations 146–148
table of appropriate statistics 126
bivariate correlations 451
bivariate normal distribution 161, 512
Bivariate platform
See Fit Y by X platform
C
carryover effects 341–342, 371
categorical variables
See classification variables
cause-and-effect relationships
multiple regression and 416–417
nonexperimental research and 15–16
cells in tables 149, 162
central tendency measures 86–87
classification variables
ANOVA versus multiple regression 414
character data types 57–58
Chart command (Graph menu) 204, 218, 247, 330
chi-square test of homogeneity 149
chi-square test of independence
assumptions underlying 162
computing 150–152
computing from raw data 152, 158
computing from tabular data 152–158
described 127
two-way classification tables 148–150
when to use 148
Choose Response menu
Contrast option 385–386
described 384–385
Identity option 308, 385
Repeated Measures option 345–346, 386–387, 397
Sum option 385–386
CI of Correlations option
(Multivariate platform) 145
classification variables
ANOVA versus multiple regression 414
classification variables (continued)
  described 9
mixed-design ANOVA 359
nominal scales and 11, 124
quantitative variables versus 9
value and 8
clipboard 61
coefficient alpha
  See Cronbach’s alpha
coefficient of determination 428
collinearity 440, 469
Cols menu
  Add Columns command 89
  Add Multiple Columns command 53, 55, 175
  Column Info command 53, 56–57, 89
  Delete Columns command 56, 78
described 49, 50–51
  Formula option 175
  New Column command 53, 55, 90, 507
  Reorder Columns command 51
column formulas 59, 65–70
Column Info command (Cols menu) 53, 56–57, 89
Column Info dialog box
  accessing Formula Editor 66–67
  changing modeling types 125
  Column Name option 69–70
Data Type menu 89
described 57
  Format option 69–70
Column Name option (Column Info dialog box) 69–70
Column Properties menu
described 59
  Formula property 59
  List Check property 60, 96–98, 235–236, 273, 305, 378
  Notes property 60
  Range Check property 60
  Value Labels property 60
columns in tables
  See also variables
  assigning properties to 58–60
  column names 56
  concatenating tables end to end 77–79
  considerations joining tables 81–82
creating and deleting 55–56
described 9–10, 51–52, 57
duplicating 56
  formulas for 59, 65–70
  selecting/highlighting 53–55
  splitting and stacking 71–74
  Columns panel (data table) 49–50, 125
comma-delimited files 62
column formulas 59, 65–70
  Column Info command (Cols menu) 53, 56–57, 89
  Column Info dialog box
    accessing Formula Editor 66–67
    changing modeling types 125
    Column Name option 69–70
    Column Properties menu
      described 59
      Formula property 59
      List Check property 60
      Notes property 60
      Range Check property 60
      Value Labels property 60
  columns in tables
  See also variables
  assigning properties to 58–60
  column names 56
  concatenating tables end to end 77–79
  considerations joining tables 81–82
  correlation coefficient
  See paired-samples t-test
correlation matrix
  multiple regression analysis 430, 432–433
  principal component analysis 474–475, 488
correlational research
  See nonexperimental research
Correlations Multivariate option (Multivariate platform) 144
counterbalancing technique 341
covariance, homogeneity of
  See homogeneity of covariance
covariates 415
criterion variables
  See response variables
Cronbach’s alpha
  computing 169–178
described 164, 168–169
  item-total correlation and 174–177
  multiple-item scale and 172–174, 177–178
  Multivariate platform for 164, 171–178
crosstabs report 313
csv file format 62
cumulative percent of variance accounted for 498–499
Currency numeric format 58
Customize Summary Statistics command (Summary Statistics title bar) 108
D
data
  See also tables
copying and pasting 61
creating subsets of 74–77
described 7
gathering 7, 447–448
managing in tables 70–83
subsets of 74–77
total variance in 479–480
data analysis
  basic approaches to research 14–18
  common language for 2–3
Index 527

descriptive versus inferential analysis 18–20
hypothesis testing in 20–29
JMP modeling types 14
observational units in 9–10
ordering values in 272–273
scales of measurement in 10–14
steps to follow 3–7
values in 8
variables in 8–9
data files See files
data formats for column data 58–59
data grid (JMP table) 49, 51–52
data manipulation computing column values with formulas 65–70
copying and pasting data 61
reading data into JMP from other files 61–65
data screening concept 86
data table panels 49–51
data tables See tables
Data Type menu 89
data types 57–58, 318
Data with Preview radio button (Open File dialog box) 63–64
Date numeric format 58
Delete Columns command (Cols menu) 56, 78
Delete Rows command (Rows menu) 56
deleting columns 55–56
rows 56
delimited data in files 62–64
Density Ellipse option (Fit Y by X platform) 139, 143, 145
dependent variables See also response variables
described 17
experimental research and 18
investment model study 186–187
statistics for pairs of variables 126
descriptive analysis See also Distribution platform
described 19, 86–87
helpfulness social survey
example 87–90
of population 19
descriptive statistics 331–333
differences See nonsignificant differences
See significant differences
directional alternative hypothesis 24–25
Display Options command (Histogram title bar) 105, 108
distribution analysis computing summary statistics 90–118
described 85–87
helpfulness social survey 87–90
outlier box plots 110–112
stem-and-leaf plots 112–117
step-by-step example 118
testing for normality 104–110
Distribution platform changing preferences for 374–375
computing summary statistics 90–118
described 85, 91
descriptive analysis and 86–87
distribution analysis example 118
generating histograms 38–39
helpfulness social survey 87–90
mixed-design ANOVA 373–382
overlay plots 377–378, 380–382
profile plots 378
testing for normality 104–110
divide operator 68
drawing conclusions 7
E
E matrix 386
Edit menu
Copy command 61
Journal command 45
Layout command 45
Paste command 61
Effect Leverage emphasis option 275
effect size 196–197, 216–217
Effect Tests table factorial ANOVA with between-subjects factor 275
multiple regression analysis 462–463
eigenvalue-one criterion 493–495
Eigenvalue table 497–498
eigenvalues described 478, 491
scree test 495–497
Ellipsoid 3D Plot option
(Multivariate platform) 145–146
emphasis types (Fit Model platform) 275, 311, 403
EMS (Expected Mean Squares) method 405–406
errors of prediction 425, 468
Exclude/Unexclude command (Rows menu) 50
Exit JMP command (Windows) 34
expected frequencies 153, 162
Expected Mean Squares (EMS) method 405–406
experimental conditions described 18
MANOVA with between-subjects factor 305–318
one-way ANOVA with between-subjects factor 231–251
experimental groups control groups versus 18, 362–364
described 18
interactions and 266–294, 366–367, 370–401
random assignment to 364–365
testing for simple effects 396–400
experimental research ANOVA and 412
choosing correct statistical procedure 516–523
dependent variables and 18
described 16–18
fixed-effects models and 27–28
independent variables and 18
predictor variables and 17
response variables and 17
F
F ratio
factorial ANOVA with between-subjects factor 289–290, 293
multiple regression analysis 462–463
one-way ANOVA with repeated-measures factor 351–352
F statistic
factorial ANOVA with between-subjects factor 281, 293
Index

F statistic (continued)

- MANOVA with between-subjects factor 301, 303–304, 309–310
- one-way ANOVA with between-subjects factor 240–242, 248, 251–253
- one-way ANOVA with repeated-measures factor 347–348, 350–351

- p-values for 240–242, 248–249, 251, 309–311
- understanding the meaning of 251–253

- Wilks' lambda and 301, 303–304, 309

Factor Analysis option (Principal Components title bar) 500

- factor analysis versus principal component analysis 480–482

- factor-based scale 506
- factor-based scores 504, 506–510

- Factor Profiling command (Whole Model title bar) 290

- Factor Rotation report 501

- factor (component) scores 504–506

- factorial ANOVA with between-subjects factor

See also mixed-design ANOVA

- aggression study 257–268
- assumptions underlying 295–296, 406–408
- described 256–257

- Fit Model platform 273–275, 287–288

- interpreting results 275–276, 279–286, 289–294

- investment model study 268–294

- possible results from 260–268

- significant interaction 266–268, 287–294

- summarizing analysis results 286–287, 294

- with nonsignificant interaction 268–287

- with nonsignificant main effects 265

- with significant main effects 261–265, 281

- factorial ANOVA with repeated-measures factor 406–408

- factorial design studies 256–260

- Fahrenheit degree scale 12

File menu

- described 33
- Exit JMP command 34
- New command 52
- Open command 32, 35, 62–64
- Preferences command 375
- Quit command 34
- Save As command 52

files

- delimited data in 62–64
- importing 62
- opening 63–64
- reading data into JMP from other 61–65

- firefighter success example 437–439

- Fisher's exact test 159–160

- Fit Model dialog box

- Construct Model Effects list 403

- emphasis types 275, 311, 344–345

- Model Effects area 344–345

- personality types 275, 303, 306, 311, 344, 383
- Run button 345, 454–455

- Select Columns list 403

- Fit Model platform

- described 273–275

- factorial ANOVA with between-subjects factor 273–275, 287–288

- MANOVA with between-subjects factor 303–304, 306, 311, 316

- mixed-design ANOVA 383–384, 394–395, 397

- multiple regression analysis 447, 454–462, 464

- overlay plots 377

- profile plots 378

- repeated-measures analysis 344–350, 403–405

- significant main effects with testing slices 291–294, 396–400

- Fit Y by X platform

- bivariate association 136, 139, 154

- computing chi-square 154

- computing Pearson correlations 139

- computing single correlation coefficient 139–141

- Contingency Table 155–157

- Density Ellipse option 139, 143, 145

- described 139

investment model study 135–138

- Means/ANOVA/Pooled t option 192, 194, 202

- one-way ANOVA with between-subjects factor 236–239, 248–249

- one-way ANOVA with repeated-measures factor 329–337

- performing t-tests in 191–198

- producing scatterplots with 43, 135–138

- Tests report 157–158

- Fitted Normal title bar 107, 109

- fixed-effects factor 27

See also independent variables

- fixed-effects models described 27

- experimental research and 27–28

- nonexperimental research and 28

- random-effects models versus 28–29

- Format option (Column Info dialog box) 69–70

- formats for column data 58–59

- Formula Editor 66–70, 175, 507–508

- Formula option (Cols menu) 175

- Formula property (Column Properties menu) 59

- formulas, column 59, 65–70

- frequencies

- expected 153

- observed 153

- Full Factorial option (Macros menu) 274

- full multiple regression equation 454–462

- Function Browser 66

G

- gathering data 7, 447–448

- gender (classification variable) 9, 11

- Go to Row subcommand (Row Selection dialog box) 54–55

- goal-setting theory 5

- Goodness-of-Fit test 107–110

Graph menu

- Chart command 204, 218, 247, 330

- described 35

- Overlay Plot option 381

- Scatterplot 3D option 487
**Group button (Summary dialog box)** 331, 379

group differences tests
  alternative hypothesis and 23–24
  described 21
  example of 26
  null hypothesis and 22–23

group effect in between-subjects designs 389–390

groups
  See control groups
  See experimental groups

<table>
<thead>
<tr>
<th><strong>H</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>H</strong> matrix 386</td>
</tr>
</tbody>
</table>

helpfulness social survey
  computing summary statistics 90–118
  described 87–90

Hide/Unhide command (Rows menu) 50

highlighting
  histogram bars 39–42
  rows and columns 53–55

histogram bars
  creating subsets 76–77
  highlighting 39–42
  ordering 96–98
  sample distributions 102–103

Histogram title bar
  Continuous Fit command 107–108
  Display Options command 105, 108
  outlier box plots 110

histograms
  creating subsets 76–77
  generating 38–39
  highlighting bars 39–42
  Hoeffding’s D option (Multivariate platform) 145

holding constant 441

homogeneity, chi-square test of 149

homogeneity of covariance
  described 342–343, 402
  factorial ANOVA assumptions 407
  MANOVA assumptions 319–320
  Mauchey's criterion 346–347

homogeneity of variance
  factorial ANOVA assumptions 296
  multiple regression assumptions 468
  one-way ANOVA assumptions 254

**t-test assumptions 222–223**

hypotheses
  alternative 23–25
  described 5
  developing 5–6
  drawing conclusions regarding 7
  null 22–23
  types of 22–25

hypothesis testing
  described 7, 20–21
  fixed effects versus random effects 27–29
  p-value 25–27
  types of hypotheses 22–25
  types of inferential tests 21–22

**I**

Identity response design 308, 385

importing data into JMP 62

independence, chi-square test of
  See chi-square test of independence

independent observations
  factorial ANOVA assumptions 295, 406
  MANOVA assumptions 318–319
  multiple regression assumptions 468
  one-way ANOVA assumptions 253, 354–355
  t-test assumptions 221–222

independent-samples t-test
  assumptions underlying 221
  described 26, 182–183
  entering data into data table 189–190
  interpreting results 194–198
  investment model study 184–204
  one-way ANOVA with between-subjects factor versus 228
  performing 191–194
  summarizing analysis results 198–201
  with nonsignificant differences 201–204

independent variables
  See also predictor variables
  described 17
  experimental research and 18
  fixed- and random-effects models 27–29
  fixed-effects factor and 27
  in interactions 266, 366

investment model study
  alternative test of 213–219
  bivariate associations 135–138
  dependent variable in 186–187
  entering data into data table 189–190
  factorial ANOVA with between-subjects factor 268–294
  independent-samples t-test 184–204
  independent variable in 187–189
  investment size construct 325–354, 360–362
  MANOVA with between-subjects factor 301–318
  mixed-design ANOVA 360–401
  multiple regression analysis 445–467
  one-way ANOVA with between-subjects factor 231–253
investment model study (continued)
one-way ANOVA with repeated-measures factor 323–325
paired-samples t-test 206–221
item-total correlations 174–177

J
JMP data
See data
JMP modeling types
See modeling types
JMP software
experimenting with 44–45
file types supported 62
JMP approach to statistics 35–36
starting JMP application 32–34
step-by-step JMP example 36–45
JMP Starter Window 33–34
JMP tables
See tables
Join command (Tables menu) 79–83
Join dialog box
Matching Specifications radio button 80–82
Select Columns For Joined Table check box 403
joining JMP tables 79–83
Journal command (Edit menu) 45
JSL scripting language 35–36

K
Kaiser-Guttman criterion 493–495
Kendall's Tau option (Multivariate platform) 145
Kolmogorov-Smirnov-Lillefor's (KSL) statistic 108
Kruskal-Wallis test 129
KSL (Kolmogorov-Smirnov-Lillefor's) statistic 108
Kurtosis
described 103
negative 103, 106
positive 103, 106

L
label points, generating 43–44
Label/Unlabel command (Rows menu) 37, 44, 50
labeling bars 247
Layout command (Edit menu) 45
Least Significant Difference (LSD) 243–244, 337
Least Squares means plot 284–286
least squares principle
multiple regression analysis 425–427
principal component analysis 478
leptokurtic distribution 103, 106
letter report 313
levels of measurement
described 9
factorial ANOVA assumptions 406
interval scales 12–13
MANOVA assumptions 318
modeling types and 14, 124–125
multiple regression assumptions 467
nominal scales 11
one-way ANOVA assumptions 354
ordinal scales 11–12
principal component analysis assumptions 512
quasi-interval 13
ratio scales 13–14
t-test assumptions 221–222
leverage plots 276–279, 458–459
Likert scale 165
linear combination of predictor variables 427
linear relationships between variables 133–134
linearity
multiple regression assumptions 468
Pearson correlation assumptions 161
principal component analysis assumptions 512
List Check property (Column Properties menu)
described 60
in Distribution platform 96–98, 378
in Fit Model platform 273, 305
in Fit Y by X platform 235–236
little jiffy factor analysis 500–501
locus of control 28
LSD (Least Significant Difference) 243–244, 337
Macintosh environment
JMP Starter Window 33
TextEdit editor 62
Macros menu 274
magnitude of the treatment effect 230–231
main effects 261
See also nonsignificant main effects
See also significant main effects
main menu bar 33
manipulated variables 17, 414–415
Manova Fit panel 383–384
Manova personality
MANOVA with between-subjects factor 303, 306
mixed-design ANOVA 383
one-way ANOVA with repeated-measures factor 344
MANOVA Summary table 400–401
MANOVA with between-subjects factor
aggression study 298–300
assumptions underlying 318–320
described 298–300
Fit Model platform 303–304
interpreting results 309–313
investment model study 301–318
summarizing analysis results 314–318
Wilks' lambda 301, 303–304, 309–311
with significant differences 305–316
MANOVA with repeated-measures factor 387–393
marginal totals 149
Marker Size command (scatterplots) 193
Markers command (Rows menu) 193
marriage encounter program
mixed-design ANOVA 361–401
one-way ANOVA with repeated-measures factor 326–329
Matched Pairs option (Analyze menu) 213, 220
Matched Pairs report 215
Matched Pairs title bar 214
matched-samples t-test
See paired-samples t-test
Matching Columns option (Oneway Analysis title bar) 333–334
Matching Fit report 335–336
matching procedure 207–209
Matching Specifications radio button (Join dialog box) 80–82
Mauchey's criterion 346–347
mean (average) 19
mean square between groups 251–252
mean square within groups 252
Means/Anova option (One way Analysis title bar) 238
Means/Anova/Pooled t option (Fit Y by X platform) 192, 194, 202
Means Comparison report 243–245, 337
means diamond in outlier box plots 111
t-tests and 154
Means for One way Anova table 249
measurement, scales of
See levels of measurement
measurement error 166, 468
measures of association
See association, measures of
Method of Moments 405
Minimal Report emphasis option 311, 403
minus operator 67
missing data
ANOVA Summary table with 282
summary statistics and 98
mixed-design ANOVA
alternative approach to 402–406
assumptions underlying 406–408
described 359–365
Fit Model platform 383–384, 394–395
interpreting results 387–392, 395–401
investment model study 360–401
marriage encounter study 361–401
possible results from 365–371
problems with 371–372
summarizing analysis results 392–393
with nonsignificant interaction 370–393
with nonsignificant main effects 370–371
with significant interaction 366–367, 393–401
with significant main effects 367–370, 383–384
mixed-effects models 28
mixed-model designs 357–408
modeling types
changing 125
described 9, 57–58
factorial ANOVA assumptions 295
JMP tables and 57–58
levels of measurement and 14, 124–125
MANOVA assumptions 318
one-way ANOVA assumptions 253
statistics for pairs of variables 126
Move Rows command (Rows menu) 51
multiple comparison procedures
described 230
factorial ANOVA with between-subjects factor 284–286
MANOVA with between-subjects factor 313
one-way ANOVA with between-subjects factor 229–230, 236–239, 243
multiple correlation coefficient (R) 427–428, 457
multiple-item scale
computing item-total correlation 174–177
Cronbach's alpha for 172–174, 177–178
multiple operator 69
multiple regression analysis
assumptions underlying 467–469
described 411–417
estimating full multiple regression equation 454–462
Fit Model platform 447, 454–462
interpreting results 427–445, 452–454
investment model study 445–467
Multivariate platform 463–464
predicting response from multiple predictors 417–427
simple statistics and correlations 449–454
summarizing analysis results 463–467
univariate statistics for 450
multiple regression coefficient 423–425, 441–445
multiple regression equation 454–462
multivariate ANOVA for repeated-measures analysis 342–354
multivariate normality
factorial ANOVA assumptions 407
MANOVA assumptions 319
one-way ANOVA assumptions 355
Multivariate platform
bivariate association 139–148, 451
CI of Correlations option 145
computing Cronbach's alpha 164, 171–178
computing multiple correlations for set of variables 141–144
computing Spearman correlations 147–148
Correlations Multivariate option 144
Covariance Matrix option 145
described 139
Ellipsoid 3D Plot option 145–146
Hoeffding's D option 145
Inverse Correlations option 145
item-total correlation 174–177
Kendall's Tau option 145
multiple regression analysis 463–464
Nonparametric Correlations option 145
other options used 143–145
Pairwise Correlations option 143, 145, 451
Partial Correlations option 145
principal component analysis 487
Spearman's Rho option 145
multivariate test assumptions 406–407

N
N Missing statistic 98
naturally occurring variables 14, 414–415
negative correlation between variables 131
negative kurtosis 103, 106
negative skewness described 104, 106
in outlier box plots 112
in stem-and-leaf plots 115–117
New Column command (Cols menu) 53, 55, 90, 507
New Column dialog box 55–56, 507–508
New command (File menu) 52
New Property menu 66–67
nominal modeling type
chi-square test assumptions 162
described 14, 57, 124
JMP tables and statistics for pairs of variables 126
nominal scales
classification variables and 11
described 11, 124
modeling type and 14, 124
nondirectional alternative hypothesis 23–25
nonexperimental research
choosing correct statistical procedure 516–523
described 14–16
fixed-effects models and 28
predictor variables and 15
response variables and 15
nonlinear relationships between variables 133–134
nonmanipulative research
See nonexperimental research
Nonparametric Correlations option (Multivariate platform) 145
nonsignificant differences
independent-samples $t$-test 201–204
MANOVA with between-subjects factor 316–318
one-way ANOVA with between-subjects factor 248–251
nonsignificant interactions
factorial ANOVA with between-subjects factor 268–287
mixed-design ANOVA 370–393
nonsignificant main effects
factorial ANOVA with between-subjects factor 265
mixed-design ANOVA 370–371
nonstandardized multiple regression coefficients 442–444
normal distributions
bivariate 161, 512
departures from 100–104
factorial ANOVA assumptions 296
histogram sample 102
multiple regression assumptions 467
one-way ANOVA assumptions 254
Pearson correlation assumptions 161
principal component analysis assumptions 512
$t$-test assumptions 222–223
testing for 98–100, 104–110
Notepad editor 62
Notes property (Column Properties menu) 60
null hypotheses
described 22–23
$p$-value and 26–27, 108, 195
test of association and 24–25
test of group differences and 22–23
numeric data formats 58
numeric data types 57–58
observation research
See nonexperimental research
Oneway Analysis title bar
Compare Means option 334–335, 337
Matching Columns option 333–334
Means/Anova option 238
Open command (File menu) 32, 35, 62–64
Open File dialog box
Data with Preview radio button 63–64
described 48
opening JMP tables 35, 37–38
optimal weights 478–479
optimally weighted combination of predictor variables 427
order effects 340–341, 371
ordinal modeling type
chi-square test assumptions 162
described 14, 57, 124
JMP tables and 57
Spearman correlation assumptions 161
statistics for pairs of variables 126
Index  533

described  11–12, 124
modeling type and  14, 124
quantitative variables and
  11–12
outlier box plots  110–112, 374
outliers
  described  102–103
distribution examples with
  108–110
histogram sample  102
Overlay Plot command (Tables
  menu)  378
Overlay Plot option (Graph menu)
  381
Overlay Plot platform  381–382
overlay plots  377–378, 380–382
P
  
  p-value
    described  25–26, 195
    for  $F$ statistic  240–242,
      248–249, 251, 309–311
    null hypothesis and  26–27,
      108, 195
    W statistic and  108, 110, 116
  paired-samples $t$-test
    assumptions underlying
      222–223
    described  183, 204–205
    interpreting results of  215–
      217
    investment model study
      206–221
    pretest-posttest studies  209,
      211–212, 219–220
    problems with  210–211
    research design examples
      205–209
    summarizing analysis results
      217–219
    when to use  211–212
  Paired $r$ Test report  217
  Pairwise Correlations option
    (Multivariate platform)
      143, 145, 451
  Parameter Estimates table
    Distribution platform  107
    factorial ANOVA with
      between-subjects factor
        275
    multiple regression analysis
      460–462
  parameters, population  19
  Partial Correlations option
    (Multivariate platform)
      145
  paste (copy and paste operations)
      61
  Paste command (Edit menu)  61
  Pearson correlation coefficient
    assumptions underlying  161
    characteristics of  131–133
    computing  139–144
    described  123–124, 128
    interpreting  131–133
    linear versus nonlinear
      relationships  133–134
    other options used  144–146
    producing scatterplots
      135–138
    when to use  130–131
  person (observational unit)  9
  personality types (Fit Model
    platform)
    factorial ANOVA with
      between-subjects factor
      275
    MANOVA with between-
      subjects factor  303, 311
    mixed-design ANOVA  383
  Platforms tab (Preferences panel)
      375
  platykurtic distribution  103, 106
    plots
      See specific types of plots
  POI instrument
    See Prosocial Orientation
    Inventory instrument
  population
    described  18
    descriptive statistical analysis
      of  19
    parameter of  19
    sample of  19, 75
    positive correlation between
      variables  131
    positive kurtosis  103, 106
    positive skewness
      described  104–105
      in outlier box plots  112
      in stem-and-leaf plots
        115–117
    predicted variables
      See response variables
    prediction errors  425, 468
    predictive equation
      regression coefficients and
        intercepts  423–425
      simple  418–422
      with weighted predictors
        422–423
    predictor variables
      ANOVA versus multiple
        regression  414
      choosing correct statistical
        procedure  516–523
  correlated  432–441
  described  15
  experimental research and
    17
  fixed- and random-effects
    models  27–29
  in interactions  266, 366
  investment model study  190
  linear combination of  427
  main effects for  261–265
  mixed-design ANOVA  359
  naturally occurring  414–415
  nonexperimental research and
    15
  optimally weighted
    combination of  427
  predicting response from
    multiple predictors
      417–427
  statistics for pairs of variables
      126
  uniqueness indices for
      440–441, 461–462
  variance accounted for by
      428–441
  Preferences command (File menu)
      375
  Preferences panel  375
  pretest-posttest studies  209, 211–
      212, 219–220
  principal component analysis
    assumptions underlying
      512
    conducting  489–511
    described  472–482
    factor analysis versus
      480–482
    Multivariate platform  487
    Principal Components platform
      478, 487, 490
    Prosocial Orientation Inventory
      instrument  482–511
    recoding reversed items for
      509–510
    Scatterplot 3D platform  487
    summarizing analysis results
      510–511
  principal components
    characteristics of  478–479
    computing  476–478
    described  476
    extracting  490–493
    optimal weights for  478
    retaining based on variance
      accounted for  497–499
    total variance in data  479–480
  Principal Components platform
      478, 487, 490
  Principal Components report  492
Principal Components title bar
Factor Analysis option 500
Save Rotated Components option 504
Scree Plot option 496–497
principle of least squares
multiple regression analysis
425–427
principal component analysis
478
Probability numeric format 58
profile plots 378
properties, assigning to columns
58–60
prosocial behavior 412–413
Prosocial Orientation Inventory instrument
conducting principal component analysis
487–511
described 482–484
minimally adequate sample size 485
number of items per component 485
preparing 484–485
Q
q statistic 243–244
qualitative variables
See classification variables
Quantiles table 374
quantitative variables
classification variables versus 9
described 9
distribution results for 92
interval scales and 12–13
ordinal scales and 11–12
ratio scales and 13–14
value and 8
quasi-interval scales 13
Quit command (Macintosh) 34
R
R (multiple correlation coefficient) 427–428, 457
R2 statistic 230–231, 283, 300
race (classification variable) 9, 11, 124
random-effects factor 27–28, 359
See also independent variables
random-effects models 27–29
random sampling
chi-square test assumptions 162
factorial ANOVA assumptions 295, 406
MANOVA assumptions 319
multiple regression assumptions 467
one-way ANOVA assumptions 253, 355
Pearson correlation assumptions 161
principal component analysis assumptions 512
r-test assumptions 221–222
random subsets of data 75
randomization in mixed-design studies 364–365
Range Check property (Column Properties menu) 60
ranking variables 124
ratio scales
described 13–14, 125
modeling type and 14, 125
quantitative variables and 13–14
statistics for pairs of variables 126
raw data
computing chi-square values 158
described 152
nonstandardized 442
tabular versus 152
reading data into JMP from other files 61–65
recoding reversed items for principal component analysis 509–510
Reference Frame option (Matched Pairs title bar) 214
reliability coefficient 167, 173
reliability of scale
See scale reliability
REML (Restricted Maximum Likelihood) method 405–406
Reorder Columns command (Cols menu) 51
repeated-measures designs assumptions for 406–408
between-subjects designs versus 228, 323, 338–342
described 322–325
factorial ANOVA 357–408
Fit Model platform 344–350, 403–405
MANOVA 387–393
mixed-design ANOVA and 359
one-way ANOVA 321–356
paired-samples t-test 206
sequence effects in 371–372
time effect in 390
two-group 362–364
Repeated Measures option (Choose Response menu) 345–346, 386–387, 397
Replace Table option (Sort dialog box) 71
research
basic approaches to 14–18
common language for 2–3
descriptive versus inferential analysis 18–20
hypothesis testing in 20–29
JMP modeling types 14
observational units in 9–10
refining research questions 4–5
scales of measurement in 10–14
steps to follow 3–7
values in 8
variables in 8–9
Response Specification panel
Choose Response menu 308, 384, 386–387, 397
E matrix 386
H matrix 386
M matrix 384–386
Test Each Column Separately
Also check box 345, 385, 387, 391
Univariate Tests Also check box 345
response variables
See also dependent variables
choosing correct statistical procedure 516–523
described 15
experimental research and 17
in interactions 266, 366
investment model study 190
mixed-design ANOVA 359
multiple regression assumptions 467
naturally occurring 414–415
nonexperimental research and 15
predicting from multiple predictors 417–427
statistics for pairs of variables 126
Restricted Maximum Likelihood (REML) method 405–406
reversed items, recoding for principal component analysis 509–510
Index 535

RMSE (Root Mean Square Error) 197, 203, 278
romantic commitment study See investment model study
Root Mean Square Error (RMSE) 197, 203, 278
Rotated Factor Loading table 501–503
Rotated Factor Pattern table 505
rotation in principal component analysis 500–503
Row Selection command (Rows menu) 54–55
Row Selection dialog box
  Go to Row subcommand 54–55
  Invert Row Selection subcommand 54–55
  Select All Rows subcommand 54–55
  Select Randomly subcommand 54–55
rows in tables
  considerations joining tables 80–82
  creating and deleting 56
  described 9–10, 51–52, 149
  selecting/highlighting 53–55
Rows menu
  Add Rows command 53, 56
  Delete Rows command 56
  described 9–10, 51–52, 149
  Exclude/Unexclude command 50
  Hide/Unhide command 50
  Label/Unlabel command 37, 44, 50
  Markers command 193
  Move Rows command 51
  Row Selection command 54–55
Rows panel (data table) 49–51
Run button (Fit Model dialog box) 345, 454–455
S
sample size
  for multiple regression 416
  for principal component analysis 486
samples
  described 19
  random 75
  statistic of 19
Save As command (File menu) 52
Save Rotated Components option (Principal Components title bar) 504
scale reliability
  Cronbach's alpha 164, 168–178
  described 164
  internal consistency 168
  measurement error and 166
  observed variables and 166
  reliability coefficient 167
  summated rating scales 165
test-retest reliability 167–168
true scores and 166
underlying constructs and 166
scales of measurement See levels of measurement
Scatterplot 3D platform 487
Scatterplot Matrix 488–489
scatterplots
  generating 43–44
  Marker Size command 193
  producing with Fit Y by X platform 135–138
  Scree Plot option (Principal Components title bar) 496–497
  scree test 495–497
  Select All Rows subcommand (Row Selection dialog box) 54–55
  Select Columns For Joined Table check box (Join dialog box) 81–82
  Select Columns list (Fit Model dialog box) 403
  Select Randomly subcommand (Row Selection dialog box) 54–55
  selection bias 364–365
  sequence effects
    carryover effects 341–342, 371
    described 340, 371–372
    order effects 340–341, 371
    Shapiro-Wilk (W) statistic 108, 110, 116
  shortest half, outlier box plots 112
  significance
    See statistical significance
  significant differences
    MANOVA with between-subjects factor 305–316
    one-way ANOVA with between-subjects factor 231–248
    one-way ANOVA with repeated-measures factor 325–338
    factorial ANOVA with between-subjects factor 266–268, 287–289
    mixed-design ANOVA 366–367, 393–401
  significant main effects
    factorial ANOVA with between-subjects factor 261–265, 281
    mixed-design ANOVA 367–370, 383–384
  simple effects (testing slices) 291–294, 396–400
  single-group design
    extension of 359–362
    problems with 327–329, 361–362
skewness
  described 104–106
  in outlier box plots 112
  in stem-and-leaf plots 114–117
Sort command (Tables menu) 71
Sort dialog box
  described 71
  Replace Table option 71
  sorting tables 71
  space-delimited files 62
Spearman correlation coefficient
  assumptions underlying 161
  computing 147–148
  described 127–128
  when to use 146–147
  Spearman's Rho option (Multivariate platform) 145
specification errors 468–469
Specification of Repeated Measures dialog box 345–346, 386–387
sphericity (homogeneity of covariance)
  described 342–343, 402
  factorial ANOVA assumptions 407
MANOVA assumptions 319–320
  Mauchey's criterion 346–347
split columns 71–74
Split Columns dialog box 74
Split command (Tables menu) 72, 74
Stack Columns dialog box 73
Stack command (Tables menu) 72, 217, 402
stacked columns 71–73, 217, 402
standard error of the mean 211
Standard Least Squares personality 303, 311
standard regression coefficients 461–462
standardized multiple regression coefficients 443
statistic
choosing correct 124–129
described 19–20
statistical significance
described 123
interactions in factorial ANOVA 289–290
magnitude of the treatment effect versus main effects in factorial ANOVA 281
variance accounted for versus 457
statistics
See also summary statistics
descriptive 331–333
for pairs of variables 126
JMP approach to 35–36
Statistics Column Name Format menu 379
Statistics menu (Summary dialog box) 330–331, 379
stem-and-leaf plots 112–117
stx file format 62
Subset command (Tables menu) 74–77
Subset dialog box 75
subsets of data
creating using histograms 76–77
creating using Subset command 74–76
Sum response design 385–386
summarizing analysis results
factorial ANOVA with between-subjects factor 286–287, 294
independent-samples t-test 198–201
MANOVA with between-subjects factor 314–318
mixed-design ANOVA 392–393
one-way ANOVA with between-subjects factor 245–247, 250–251
one-way ANOVA with repeated-measures factor 338, 353–354
paired-samples t-test 217–219
principal component analysis 510–511
Summary command (Tables menu) 331, 378–379
Summary dialog box
Group button 331, 379
Statistics Column Name Format menu 379
Statistics menu 330–331, 379
Summary of Fit table
factorial ANOVA with between-subjects factor 275–276, 278
multiple regression analysis 457
summary statistics
creating table of 331–332
departures from normality 100–104
described 90–91
distribution analysis example 118
Distribution platform 91–95, 104–110
missing data 98
ordering histogram bars 96–98
outlier box plots 110–112
stem-and-leaf plots 112–117
testing for normality 98–100, 104–110
Summary Statistics table 374–377
Summary Statistics title bar 108
summarized rating scales 165
suppressor variables
correlated predictor variables and 432–440
described 436–437
symmetry condition 407–408
T statistic
26, 194–195, 215–216
t-tests
assumptions underlying 221–223
described 182
independent-samples 26, 182–204
interpreting results 194–198
means comparisons and 243–244
paired-samples 183
performing in JMP 191–198
with nonsignificant differences 201–204
tab-delimited files 62
Table panel (data table)
described 49–50
Tables command 50
tables
See also columns in tables
See also rows in tables
assigning properties to columns 58–60
cells in 149, 162
Columns panel 49–50, 124
concatenating end to end 77–79
contingency 148–150
creating 52–56
creating subsets of data 74–77
data grid in 49, 51–52
data table panels in 49–51
data types and 57
described 52
examining 37–38
factorial data in 271–272
investment model study 189–190
joining side by side 79–83
managing data in 70–83
modeling types and 57–58
opening 35, 37–38
reading data into 61–65
reviewing for multivariate analyses 343–344
Rows panel 49–51
sorting 71
structure of 48–52
Table panel 49–50
two-way classification 148–150, 155–157, 159–160
Tables command (Table panel) 50
Tables menu
Concatenate command 77–79
described 49
Join command 79–83
Overlay Plot command 378
Sort command 71
Split command 72, 74
Stack command 72, 217, 402
Subset command 74–77
Summary command 331, 378–379
Transpose command 378, 380–381
tabular data
computer chi-square values 152–158
described 152
raw versus 152
Test Each Column Separately Also check box (Response Specification panel) 345, 385, 387, 391
test-retest reliability 167–168
Index 537

Test Slices command (Interaction title bar) 292
Test Slices report 292–293
testing for normal distribution 98–100, 104–110
testing slices (simple effects) 291–294, 396–400
tests of association
See association, measures of
Tests report (Fit Y by X platform) 157–158
Text Edit editor 62
Text Import Preview dialog box 64–65
time effect in repeated-measures designs 390
Time numeric format 58
Time report 347
times (trials) 359
Tip of the Day tips 32
Tools menu 247
total variance 479–480
Transpose command (Tables menu) 378, 380–381
treatment conditions 18, 340–342
trials (times) 359
tip scores 166
ture zero point 12–14
Tukey's HSD test
factorial ANOVA with between-subjects factor 284–286
MANOVA with between-subjects factor 311–313
one-way ANOVA with between-subjects factor 236–239, 244–245
two-group repeated-measures design 362–364
two-sided statistical tests, nondirectional alternative hypotheses and 25
two-tailed tests
See two-sided statistical tests
two-way ANOVA
See factorial ANOVA with between-subjects factor
See two-way mixed-design ANOVA
two-way classification tables 148–150, 155–157, 159–160
two-way mixed-design ANOVA alternative approach to 402–406
assumptions underlying 406–408
described 359–365
Fit Model platform 383–384, 394–395
interpreting results 387–392, 395–401
investment model study 360–401
marriage encounter study 361–401
possible results from 365–371
problems with 371–372
summarizing analysis results 392–393
with nonsignificant interaction 370–393
with nonsignificant main effects 370–371
with significant interaction 366–367, 393–401
with significant main effects 367–370, 383–384
txt file format 62
Type I errors 343
U
underlying constructs 166
uniqueness indices 440–441, 462–463
univariate ANOVA for repeated-measures analysis 342–354
univariate repeated-measures analysis 402–408
univariate statistics for multiple regression analysis 450
univariate test assumptions 407–408
Univariate Tests Also check box (Response Specification panel) 345
V
validating data for Range Check property 60
validity, testing for hypothesis 7
Value Labels property (Column Properties menu) 60
values
classification variables and 8
computing for columns with formulas 59, 65–70
described 8
in scales of measurement 11–14
quantitative variables and 8
statistic and 19
variable reduction procedure
See principal component analysis
variable redundancy 473–475
variables
See also specific types of variables
choosing correct statistical procedure 516–523
correlation between 131–133
data formats for 58–59
described 8, 57
relationships between 133–134
scales of measurement and 9–14
statistics for pairs of 126
variance, homogeneity of
See homogeneity of variance
variance accounted for
by correlated predictor variables 432–441
by predictor variables 428–432
cumulative percent of 498–499
retaining principal components based on 497–499
statistical significance versus 457
varimax rotation 500, 505
Venn diagrams
correlated predictor variables 434–435, 440–441
predictor variables 429, 431
W
W (Shapiro-Wilk) statistic 108, 110, 116
weighted predictors 422–424
weighted principal components 478
whiskers, outlier box plots 112
whole model reports 276–279
Whole Model table 309–311
Whole Model title bar 290
Wilks' lambda
described 300–301
F statistic and 301, 303–304
MANOVA with between-subjects factor 301, 303–304, 309–311
Windows environment
JMP Starter Window 33–34
Notepad editor 62
X
X-variables
See predictor variables
xls file format 62
xpt file format 62
Y
Y-variables
  See response variables

Z
z score form 443
Gain Greater Insight into Your JMP® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore
for additional books and resources.